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This guide explains the minimum required settings to configure a remote control system, taking the following 
illustration as an example. In this example, a radio is connected to the Base station’s PC with the supplied USB 
cable, and a remote station remotely controls the radio through the network.

 • We recommend that you place the Remote station’s PC near to the Base station's PC and a radio, to check that 
the settings are correct, and that you can correctly control the radio. 

 • You need to register the ID and password to the Base station to enable the Remote station to access the Base 
station and the radio. BE CAREFUL in managing IDs and passwords.

 • See the Instruction Manual, for detailed instructions on the RS-BA1. 
You can also refer to each software’s help file, for assistance with the functions and settings. 
While the software is open, push the [F1] key of the PC’s keyboard to open the help file.

Example of the remote control system

RC-28 

(Optional)

InternetInternet

Icom radio Base station Remote station

CI-V address : 94

Baud rate : Auto

PC Name  : Base PC

IP address  : 192.168.0.10

Computer name : BasePC

PC Name : User PC

User ID : USER1

Password : USER0001

USB cable

(Supplied to the 

RS-BA1 or a radio)

Router
IC-7300

NOTE:

The password, and other settings in this illustration 
are only an example. Please configure the system 
using your own settings.

For your convenience:

If you connect an RC-28 remote encoder to the 

Remote station, you can use the RS-BA1 and feel 
like you are operating the actual transceiver’s main 
dial, [TRANSMIT] key and so on.

This guide contains instructions on how to configure the remote control system, and how to remotely control a 
radio.

If you are using one of the following radios and connecting to the network directly, see the Installation guide B 

(For radios with the Network function). (As of August 2017)
 • IC-7851
 • IC-7850
 • IC-7800 (Firmware version 3.00 or later)
 • IC-7700 (Firmware version 2.00 or later)
 • IC-7610

Before reading this guide, please finish the installation, using the RS-BA1 Preparations.
See the RS-BA1 Instruction Manual for detailed instructions.
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Step1. Connect the radio to the Base station's PC

Before connecting the radio to the PC, please finish the installation for the Base station's PC and the Remote 
station's PC, using the RS-BA1 Preparations.

Step1.  2.  3.  4.  5.  6.

The Network function enables the radio to directly connect to the network. With this function, the base station PC is not 
necessary. See the Installation guide B (For radios with the Network function).

Radios with the Network function (As of August 2017)
 • IC-7851
 • IC-7850
 • IC-7800 (Firmware version 3.00 or later)
 • IC-7700 (Firmware version 2.00 or later)
 • IC-7610

Check the connector type on your radio and see the following chart to connect your radio to the Base station’s 
PC.
To connect an Icom CI-V command capable radio to the Base station’s PC, you have to make connections for 
control command and audio communication.

RS-BA1 operation with the Base station’s PC connected to the radio’s ACC socket, MIC connector, or S/P DIF 
jack for audio communication cannot be guaranteed.
 • This guide explains the USB connection as example. See the RS-BA1 Instruction Manual (“2. WHEN 
CONNECTING TO THE NETWORK THROUGH A PC” section) when connecting to the radio's [REMOTE] jack 
or [RS-232C] port.

Radio's connector
Outline

Model Ref.
Control command Audio

When connecting to the 

radio's [USB] port
Through a USB cable

IC-7100/IC-7200/
IC-7300/IC-7410/
IC-7600*1/IC-7610/
IC-7850/IC-7851/
IC-9100

p. A-3

When connecting to the 

radio's [REMOTE] jack

Through the CT-17 ci-v 

level converter

Through an audio cable connected between 
the PC’s audio terminal and the radio’s [ACC] 
socket or [MIC] connector

All

RS-BA1

Instruction 

Manual

When connecting to the 

radio's [RS-232C] port

Through an RS-232C 
cable

Through an audio cable connected between 
the PC’s audio terminal and the radio’s [ACC] 
socket, [MIC] connector or [S/P DIF] jack

IC-7700/IC-7800*2
RS-BA1

Instruction 

Manual

Select the connection pattern

*1 When you turn your radio ON or OFF from the Remote Controller, connect to the radio's [Remote] jack.
*2  When you turn your radio ON or OFF from the Remote Controller, connect to the radio's [Remote] jack or to the network 

directly.

RC-28 

(Optional)

Remote stationBase station

Connect to 

the LAN port

A radio with the server function

Router

InternetInternet
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Step1. Connect the radio to the Base station's PC (Continued)

 DWhen connecting to the radio’s [USB] port
For IC-7600 users
When you turn your radio ON or OFF from the Remote Controller, connect to the radio's [Remote] jack.

1. System requirements

 • A PC that has a USB 1.1, 2.0 or 3.0 port
 • Icom CI-V command capable radio that has a [USB] 
port (Type B/Mini-B)

 • The USB cable (supplied to the RS-BA1 or a radio)

2. Install a USB driver

CAUTION:

 • NEVER connect the radio to the PC with the USB 
cable until the USB driver installation has been 
completed.

 • The driver is not supported by the Windows® 
automatic recognition system.

To use the USB cable between the radio and the PC, 
you must first install a USB driver.
 • The USB driver comes with the RS-BA1. Or 
download from the Icom website.

NOTE: When a PC with USB 3.0 port is used for 
operating the radio, confirm the driver name. If 
the name “Silicon Laboratories CP210x USB to 
UART Bridge (Driver Removal)” is displayed on the 

Control Panel screen, uninstall it and then install 

the latest driver.

The latest driver and installation guide can be 
downloaded from here:
     http://www.icom.co.jp/world/index.html

Read the installation guide before installing the driver.

3. Connect the radio to the Base station’s PC

Connect the radio to the Base station’s PC using the 
USB cable.
 • This guide is based on using a Type B USB cable.

USB cable

Radio

(Rear panel)

PC

To the USB port

To a USB port

ACC

KEY1 2 METER REMOTE

Step1.  2.  3.  4.  5.  6.

NOTE: If you connect a new USB audio device 
to your PC, the device selected as the default on 
your PC can be changed. Moreover, never connect 
another radio using a USB cable while the Remote 
Utility is open.
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Step2. Radio’s presettings

The RS-BA1 remotely controls Icom radios using CI-V (Icom Communication Interface) commands. See the CI-V 
command table in the radio’s instruction manual for details of the functions that can be controlled.

1. The following manual settings are required when operating the RS-BA1

Properly preset the items in below table for functions that cannot be controlled by CI-V commands or the item 
may cause unwanted actions. See the radio’s instruction manual for details of the settings or operation.
NOTE:

 • Remove the transverter from the radio, if it is connected.
 • To prevent an accidental transmission, we recommend you remove any keyer, keypad or other external 
equipment connected to the radio.

 • Set the radio to a normal operating mode. The radio cannot receive CI-V commands while in special modes, 
such as the firmware update mode or cloning mode.

 • If the radio has a Time-Out Timer function, we recommend you enable it to prevent the radio from continuously 
transmitting.

1.  Step2.  3.  4.  5.  6.

If you are using the IC-PW1 with the transceiver, be sure to set the CI-V baud rate to 19200 bps. After changing 
the transceiver’s CI-V settings, be sure to reset the CPU of the IC-PW1 and set the transceiver’s CI-V settings 
on the IC-PW1. See the IC-PW1 instruction manual for details.

Genre Item Model Setting

Function RIT function All Set to OFF.
∂TX function All Set to OFF.
Simple band scope IC-746PRO*/IC-7000*/IC-7100/IC-7400*/IC-9100 Set to OFF.
SWR Measurement function IC-746PRO*/IC-7000*/IC-7100/IC-7400*/IC-9100 Set to OFF.
Timer/Sleep Timer function Radios with the timer function Set the timer to OFF or to your schedule.
Weather Alert function IC-7100 Set to OFF.

Display RTTY decode screen IC-746PRO*/IC-756PROIII*/IC-7400* Exit the screen.
Volume Volume for the RX audio All Set the volume to a suitable level.

CI-V CI-V address All Set an appropriate CI-V address.

CI-V baud rate All Set to 19200 bps (or Auto).
CI-V USB Port IC-7300/IC-7610/

IC-7850 (Firmware version 1.10 or later)/
IC-7851 (Firmware version 1.10 or later)

To use the Scope function when 
connecting to the USB port, set to Unlink 
from [REMOTE].

CI-V USB Baud Rate IC-7300/IC-7610/
IC-7850 (Firmware version 1.10 or later)/
IC-7851 (Firmware version 1.10 or later)

To use the Scope function when 
connecting to the USB port, set to 
115200 (or Auto).

Set mode USB Serial Function Radios with a USB (B type) port Set to “CI-V” for the selected connection 
type.

RS-232C Function Radios with an RS-232C port Set to “CI-V” for the selected connection 
type.

* Operation on models without a USB connection cannot be guaranteed.
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Step2. Radio’s presettings (Continued)

2. The following settings are automatically set to the radio

When the RS-BA1’s Remote Controller connects to the radio, and you select the model name on the Connect 
Setting screen, the following may be automatically set, depending on the model. When you manually operate the 
radio, set these items as desired.

Genre Item Model Action

Function MAIN/SUB Tranking function IC-7610/IC-7850 (Firmware version 1.10 or 
later)/
IC-7851 (Firmware version 1.10 or later)

Automatically set to OFF.

RIT function Radios with the Network function/
IC-7100 (Firmware version 1.10 or later)/
IC-7600 (Firmware version 2.00 or later)

Automatically set to OFF.

∂TX function Radios with the Network function/
IC-7600 (Firmware version 2.00 or later)

Automatically set to OFF.

SSB/CW Synchronous Tuning All Automatically set to OFF.
Calibration Marker Radios with Calibration Marker function Automatically set to OFF.

VOX function All Automatically set to OFF.
Scan function All Automatically cancel the scan.
RTTY filter IC-746PRO*/IC-756PROIII*/IC-7400* Automatically set to OFF.
Twin Peak Filter IC-746PRO*/IC-756PROIII*/IC-7400* Automatically set to OFF.

Display Dualwatch function Radios with the Dualwatch function Automatically set to OFF.
SUB band IC-9100 Automatically set to OFF.
Memory channel/Call channel All Automatically set to the VFO mode.

Operating 

mode

DR (D-STAR® REPEATER) 
mode 

Radios with the DV mode Automatically set to OFF.

Satellite mode Radios with the Satellite mode Automatically set to OFF.
CI-V CI-V transceive All Automatically set to ON.

CI-V 731 Mode IC-746PRO*/IC-756PROIII*/IC-7400* Automatically set to OFF.

* Operation on models without a USB connection cannot be guaranteed. 

1.  Step2.  3.  4.  5.  6.
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Step3. Before configuration
To configure the remote control system, the following settings are required. 

 DFirewall setting (RS-BA1 Instruction Manual p. 1)
To let the Remote Utility work properly, it must be added as an exception in the Firewall. See the RS-BA1 
Instruction Manual for details.

 DVolume adjustment for your audio devices (RS-BA1 Instruction Manual p. 6)
Before you start communicating using the RS-BA1, the PC’s audio volume must be set to a proper level.
When your PC is used as a Base station, adjust the audio level of the device that is connected to your radio.
When your PC is used as a Remote station, adjust the audio level of the device that your microphone, speaker, 
or headset is connected to.

 DTo allow access from the Internet (RS-BA1 Instruction Manual p. 12)
If you configure the remote control system through the Internet, you need to configure your Base station and 
Remote station routers to allow access from the Internet.
Configure the port forwarding settings, and IP filter settings on your router, for port numbers 50001, 50002, and 
50003 which are used for the Remote Utility.
See your router’s manual for details of how to configure the settings.

See the RS-BA1 Instruction Manual (“1. BEFORE USING REMOTE CONTROL SYSTEM” section) for details.

1.  2.  Step3.  4.  5.  6.
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Step4. Settings on the Base station’s PC

This section describes how to setup the Base station (Server) PC. Before configuring the settings, turn on the 
radio.

See the RS-BA1 Instruction Manual (“2. WHEN CONNECTING TO THE NETWORK THROUGH A PC” section) 
for details.

1.  2.  3.  Step4.  5.  6.

1 Open the Remote Utility.

1. Double-click the “Remote Utility” icon on 

your desktop to open the Remote Utility.
2. “Please set your own PC information” is 

displayed, then click <OK>.

 L When you first open the Remote Utility, this 
screen is displayed.

2 Configure the settings.
 L When you first open the Remote Utility, this screen 
is displayed.

Click <OK>, and then restart the Remote Utility.

3

Click

1Enter

2Confirm

3Select

4Select

5Click

6Click

Click the Setup that you want to do.
 L If no Servers and no radios are registered, this 
screen is displayed.

Click

4 Start the Setup Wizard.

Click

5 Select a Radio for the Remote operation.

1Select

2Click
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Step4. Settings on the Base station’s PC (Continued)

1.  2.  3.  Step4.  5.  6.

6 Select a Radio.

7 Set the CI-V/COM port settings.

Click

1Select

2Click

 L If the radio is not listed, click the <Search> 
button.

 L If the radio is connected to the PC using other 
than a USB cable, select from the Manual 
drop-down list.

If the radio is connected to the PC using other 
than a USB cable, the Audio Settings screen is 
displayed.
Select the devices that input a received audio from 
the radio and output a modulation to the radio, and 
then click <Next>>.

8 Register a User to accept connection.

1Click

2Enter

3Enter

4Click To set the user as 

an administrator, 
click to make a 
check mark.

5Click 6Click

7Click

To prevent unauthorized access:

Set a long and strong password so that no one can 
possibly guess it.
Mix upper and lower case letters, numbers or 
characters.

( Example: 

USER0001)
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Step4. Settings on the Base station’s PC (Continued)

1.  2.  3.  Step4.  5.  6.

9 Enter the radio name.

Click

 LThe radio’s model name and the last 5 figures 
of the serial number is entered by default.

10 The registration of the Radio is completed.

Click

By connecting the Radio to a USB port, the 
default settings on the REC/PLAY device 
window may change to the Radio’s Speaker 
and Microphone. To confirm the settings, click 
<Sound Settings>.
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Step5. Settings on the Remote station’s PC

This section describes how to setup the Remote station (Client) PC.
Before configuring the settings, connect a speaker and  microphone, or headset to the Remote station’s PC.
See the RS-BA1 Instruction Manual (“4. SETTINGS FOR A REMOTE STATION PC” section) for details.

1.  2.  3.  4.  Step5.  6.

1 Open the Remote Utility.

1. Double-click the “Remote Utility” icon on 
your desktop to open the Remote Utility.

2. “Please set your own PC information” is 
displayed, then click <OK>.

 L When you first open the Remote Utility, this 
screen is displayed.

2 Configure the settings.
 L When you first open the Remote Utility, this screen 
is displayed.

Click <OK>, and then restart the Remote Utility.

3

Click

1Enter

2Confirm

3Select

4Select

5Click

6Click

Click the Setup that you want to do.
 L If no Servers and no radios are registered, this 
screen is displayed.

Click

4 Start the Setup Wizard.

Click

5 Enter the Server Information.

1Enter

2Click
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Step5. Settings on the Remote station’s PC (Continued)

1.  2.  3.  4.  Step5.  6.

6 Enter the User ID and Password.

After clicking <Next>>, connects to the Server.

1Enter

3Click

2Enter

NOTE:

If you cannot connect to the Server, the error 
screen is displayed.
Click <<Back>, and confirm the settings.

7 Adding the Server has completed.

Click

8 Connect the radio.

1Click

2Click

3Select

4Select

5Click

6Click

7Click

(Example: USER0001)
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Step6. Remote control operation

This section describes how to connect and remotely control a radio from a Remote station, using the Remote 
Controller.
See the RS-BA1 Instruction Manual (“5. REMOTE CONTROLLER’S BASIC OPERATION” section) for details.
 • Since cannot turn the radio ON or OFF with remote control operation, the radio must be turned ON.
 • The description in this section is based on the assumption that the connection to the radio using the Remote 

Utility has succeeded (“<<Connected>>” is displayed under the radio name).

1 Connect setting using the Remote Controller

1. Double-click the “RS-BA1 Remote Control” icon on your desktop to open the Remote 
Controller.

2. Click the icon to the right in the toolbar, or click “Connect Setting...” in the “Option” menu.
 • The Connect Setting screen is displayed.

3. Configure the connect settings as described below.
1	Select a radio that you want to control in the “Model” menu. (Example: IC-7300)
2	Select the connection between the transceiver and Base station in the “Connection” item.  

(Example: USB)
 • When the “MOD Select has also been changed.” dialog is displayed, click <OK>.
 • The confirmation dialog for the connection setting may be displayed, depending on the transceiver. If connected 
correctly, click <OK>.

3	Select a radio that you are accessing using the Remote Utility, in the “Remote Utility” menu. 
(Example: IC-7300 XXXXX)
 • The CI-V settings are automatically loaded from the Remote Utility to the CI-V field. The settings include the 
virtual COM Port number, radio’s CI-V address and baud rate and the virtual audio device for the Voice Memory 
function.
 L If the desired radio is not displayed in the “Remote Utility” menu, click <Search> to load the radios’ information 
from the Remote Utility.

4	Click <OK> to save the settings and close the screen.

1Select

3Select

4Click

2Select

1.  2.  3.  4.  Step5.
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Step6. Remote control operation (Continued)

NOTE: DO NOT allow the PC to go into the sleep or standby mode while using the RS-BA1. Otherwise, it might 
not work properly after the PC resumes normal activity.

When not using the radio:

 • Disconnect the radio from both the Remote Controller and Remote Utility.
 • Even if you disconnect from the radio, it does not turn OFF the radio.
 • When using a radio that can be turned ON or OFF with the CI-V Power ON/OFF command: 
-  If you check the “Software closing turns OFF the Radio.” box, when you close the Remote Controller, the 

radio’s power is also turned OFF.
-  If you do not check the “Software closing turns OFF the Radio.” box, be sure to disconnect the radio from 

Remote Controller, first. And close the Remote Controller, and then close the Remote Utility.
 • When you manually select the transmit audio input connector(s) to be used after finishing the Remote 
mode, right-click the icon to the right in the toolbar, or click “Remote Setting...” in the “File” menu to 
select. 

-  Regularly, it automatically returns to the original setting before you start the Remote mode.

Importing the repeater list: You can easily program the DV mode repeater information by importing the 
repeater list preprogrammed for each radio. See the RS-BA1 Remote Controller’s Help file for importing details.

Selecting a modulation input connector

1. Click [MIC SET] on the Remote Controller.
2. The MIC SET screen appears. 

Select an appropriate connector in the “MOD Select (Remote ON)” menu (ex. USB), to 
input transmit audio from the PC to the radio. Then, click the close button to close the 
screen.

2Click

1Select

2

3

Connecting to the radio using the Remote Controller

Click the icon to the right in the toolbar, or click “Connect ON” in the “File” menu, to connect to the 
radio.

 • When the connection has succeeded, the radio’s current data will be displayed on the main panel.
 • The modulation input is automatically selected, depending on the setting in the “Connection” item. 
However, if you select other than “USB,” or you want to use other connector than USB port, see “Selecting 
a modulation input connector” described below for details. 

Remote control operation

See the RS-BA1 Remote Controller’s help file for remote operation details, such as how to change the 
frequency, or turn ON each function.
To display the help file, click “Contents” in the Help menu on the Remote Controller, or push the [F1] key on 
your PC’s keyboard.

1.  2.  3.  4.  Step5.
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RS-BA1 For radio with the Network function

Installation guide B

This guide explains the minimum required settings to configure a remote control system, taking the following 
illustration as an example. In this example, a Remote station remotely controls a Base station radio through the 
network.

 • We recommend that you place the Remote station’s PC near the Base station to check that the settings are 
correct, and that you can correctly control the radio. 

 • Only users whose ID and password are registered on the Base station can access the Base station radio. BE 
CAREFUL in managing IDs and passwords.

 • See the Instruction Manual for detailed instructions on the RS-BA1. 
You can also refer to each software’s help file for assistance with the functions and settings. 
While the software is open, push the [F1] key of the PC’s keyboard to open the help file. 

RS-BA1 For radio with the Network function

Installation guide B

This guide contains instructions on how to configure the remote control system, and how to remotely control a 
radio with the Network function*.
Before reading this guide, please finish the installation, using the RS-BA1 Preparations.
See the RS-BA1 Instruction Manual for detailed instructions.
*Radios with the Network function (As of August 2017)
 • IC-7851
 • IC-7850
 • IC-7800 (Firmware version 3.00 or later)
 • IC-7700 (Firmware version 2.00 or later)
 • IC-7610

If you use other Icom radio, see the Installation guide A.

Example of the remote control system

NOTE:

The user ID, password, and other settings in this 
illustration are only an example. Please configure 
the system using your own settings.

For your convenience:

If you use an RC-28 remote encoder at the 

Remote station, you can use the RS-BA1 and feel 
like you are operating the actual radio’s main dial, 
[TRANSMIT] key and so on.

IP address: 192.168.0.10 IP address: 192.168.0.1

RC-28 

(Optional)

Remote station

PC Name:

User ID:

Password:

User PC

USER1

USER0001

Base station

IC-7851abc

8Eh

Auto

Network Radio Name:

CI-V address:

Baud rate:

Connect to 

the LAN port

These instructions are based on using the IC-7851.

IC-7851

A radio with the server function

InternetInternet

Router
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2. The following settings are automatically set to the radio

When the RS-BA1’s Remote Controller connects to the radio, and you select the model name on the Connect 
Setting screen, the following items are automatically set. When you manually operate the radio, set these items 
as desired.

Step1.  2.  3.  4.  5.

Step1. Radio’s presettings

The RS-BA1 remotely controls the radios with the Network function using CI-V (Icom Communication Interface) 
commands.

See the CI-V command table in the radio’s instruction manual for details of the functions that can be controlled.

1. The following manual settings are required when operating the RS-BA1

Properly preset the items in the table below for functions that cannot be controlled by CI-V commands, or 
for items that may cause unintended actions. See the radio’s instruction manual for details of the settings or 
operation.

NOTE:

 • Remove any transverter that is connected to the radio.
 • To prevent accidental transmission, remove any keyer, keypad or other external input equipment connected to 
the radio.

 • We recommend you enable the Time-Out Timer function to prevent the radio from continuously transmitting.
transmitting.

If you are using the IC-PW1 with the transceiver, be sure to set the CI-V baud rate to 19200 bps. After changing 
the transceiver’s CI-V settings, be sure to reset the CPU of the IC-PW1 and set the transceiver’s CI-V settings 
on the IC-PW1. See the IC-PW1 instruction manual for details.

Genre Item Setting

Function Timer/Sleep Timer function Set the timer to OFF or to your schedule
Volume Volume for the RX audio Set the volume to a suitable level

CI-V CI-V address IC-7851/IC-7850: 8Eh, IC-7800: 6Ah, IC-7700: 74h, IC-7610: 98h
( When another device is connected to the system, make sure you do not to set a 
duplicate address.)

CI-V baud rate Set to 19200 bps (or Auto)

Genre Item Action

Function MAIN/SUB Tranking function
(For only the IC-7851, IC-7850, IC-7610)

Automatically set to OFF

RIT function Automatically set to OFF
∂TX function Automatically set to OFF
SSB/CW Synchronous Tuning Automatically set to OFF
Calibration Marker Automatically set to OFF

VOX function Automatically set to OFF
Scan function Automatically cancel the scan

Display Dualwatch function
(For only the IC-7851, IC-7850, IC-7800, IC-7610)

Automatically set to OFF

Memory channel Automatically set to the VFO mode
CI-V CI-V transceive Automatically set to ON
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To configure the remote control system, the following settings are required.

 DFirewall setting (RS-BA1 Instruction Manual p. 1)
To let the Remote Utility work properly, it must be added as an exception in the Firewall. See the RS-BA1 
Instruction Manual for details.

 DTo allow access from the Internet (RS-BA1 Instruction Manual p. 12)
If you configure the remote control system through the Internet, you need to configure the Base station and 
Remote station routers to allow Internet access.
Configure the port forwarding settings and IP filter settings on your router for port numbers 50001, 50002, and 
50003 which are used for the Remote Utility.
See your router’s manual for details of how to configure the settings.

 DVolume adjustment for your audio devices (RS-BA1 Instruction Manual p. 6)
Before you start communicating using the RS-BA1, the PC’s audio volume must be set to a proper level.
Adjust the audio level of the device that your microphone, speaker, or headset is connected to.
If you connect the microphone, speaker, or headset after setting the audio level, confirm the level has not 
changed.

See the RS-BA1 Instruction Manual (“1. BEFORE USING REMOTE CONTROL SYSTEM” section) for details.

1.  Step2.  3.  4.  5.

Step2. Before configuration
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In this guide, explains how to set the radio for 
operating the remote control system through the LAN.
When using the remote control system using the 
Internet, read the RS-BA1 Instruction Manual 
(“3. WHEN CONNECTING TO THE NETWORK 
DIRECTLY” section).

This section describes how to setup the Base station.
Before configuring the settings, turn ON the radio.

To prevent unauthorized access:

Set a long and strong password so that no one can 
possibly guess it.
Mix upper and lower case letters, numbers or 
characters.

 • Except for the IC-7610

1. Hold down [EXIT/SET] for 1 second to select the 
Set mode menu screen.

2. Push [OTHERS](F-5) to enter the Others set 
mode.

3. Push [▲](F-1) or [▼](F-2) to select the desired 
item.
 • See page B-5 for the setting items.

4. Adjust/select or enter the needed contents.
 • See page B-5 for the setting contents.
 • Hold down [DEF](F-4) for 1 second to return them to 
their defaults.

 • See the RS-BA1 Instruction Manual for details.
5. Push [EXIT/SET] to exit the Set mode. 

NOTE: When you change the setting that 
shows “(Valid after Reboot),” you have to reboot 
the radio after setting, so they will take effect.
 • After the reboot, keep the radio’s power ON, 
or remain in the remote standby mode.

 • For the IC-7610

1. Push [MENU] to display the MENU screen.
2. Touch [SET] to enter the Set mode.
3. Touch the category that you want to select.
4. Touch the item to open the item’s setting screen, 

or open its next tree level.
 • See page B-5 for the setting items.

5. Touch to select or set the option.
 • See page B-5 for the setting contents.
 • Push [QUICK] and touch “Default” to return them to 
their defaults.

 • See the RS-BA1 Instruction Manual for details.
6. Push [MENU] to exit the Set mode. 

NOTE: When you change the setting that 
shows “(Valid after Restart),” you have to restart 
the radio after setting, so they will take effect.
 • After the restart, keep the radio’s power ON, 
or remain in the remote standby mode.

Step3. Setting the Network function on the radio

1.  2.  Step3.  4.  5.
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[Setting items and contents]

 • Network setting 

(Except for the IC-7851, IC-7850, and IC-7610)

Items Contents

Network Control OFF (Default)  ON
IP Address IP address that is not assigned to 

any other device.
Example:  192.168.0.10  

(Default)
Default Gateway IP address of the LAN side on 

the router

Example:  192.168.0.1
Control Port (UDP) 50001 (Default)
Serial Port (UDP) 50002 (Default)
Audio Port (UDP) 50003 (Default)
Internet Access Line Your internet access line type

Example: FTTH (Default)

 • Network setting 

(For the IC-7851, IC-7850, and IC-7610)

Items Contents

Network Control OFF (Default)  ON
DHCP* ON (Default)
Network Name* Desired Network Name

Example:  IC-7851
Control Port (UDP) 50001 (Default)
Serial Port (UDP) 50002 (Default)
Audio Port (UDP) 50003 (Default)
Internet Access Line Your internet access line type

Example: FTTH (Default)

* If you are setting the IP address instead of the network radio 
name, set the DHCP item to OFF. For the other settings, see 
“Network setting (Except for the IC-7851, IC-7850, and IC-7610).”

 • Radio registration

Items Contents

Network Radio Name Desired Network Radio Name
 • Up to 16 characters

Example:  IC-7851abc
CI-V Address Desired CI-V Address

Example: the radios’ default 
setting.

IC-7851/IC-7850: 8Eh
IC-7800: 6Ah
IC-7700: 74h
IC-7610: 98h

CI-V Baud Rate Desired Baud Rate

Example: Auto (Default)

 • User registration

Items Contents

Network User1/2/3*
ID

Desired User ID
 • Up to 16 characters

Example: USER1
Network User1/2/3*
Password

Desired Password
 • 8 to 16 characters
 • At least two different characters 
must be used.

Example: USER0001
Network User1/2/3*
Administrator

NO (Default)  YES
 • In case the user is set as an 

administrator.

* When using IC-7610, Network User3 is not used.

 • Transmitting audio setting 

(For the IC-7800 and IC-7700)

Items Contents

Network MOD Use ON (Default)

1.  2.  Step3.  4.  5.

Step3. Setting the Network function on the radio (Continued)
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This section describes how to setup the Remote station (Client) PC.
Before configuring the settings, connect a speaker and  microphone, or a headset to the Remote station’s PC.
Before configuring the settings, turn ON the radio.
See the RS-BA1 Instruction Manual (“4. SETTINGS FOR A REMOTE STATION PC” section) for details.

1 Open the Remote Utility.

1. Double-click the “Remote Utility” icon on 
your desktop to open the Remote Utility.

2. “Please set your own PC information” is 
displayed, then click <OK>.

 L When you first open the Remote Utility, this 
screen is displayed.

2 Configure the settings.
 L When you first open the Remote Utility, this screen 
is displayed.

Click <OK>, and then restart the Remote Utility.

Step4. Settings on the Remote station’s PC

1.  2.  3.  Step4.  5.

3

Click

1Enter

2Confirm

3Select

4Select

5Click

6Click

Click the Setup that you want to do.
 L If no Servers and no radios are registered, this 
screen is displayed.

Click

4 Start the Setup Wizard.

Click

5 Enter the Server Information.

1Enter

2Click
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1.  2.  3.  Step4.  5.

Step4. Settings on the Remote station’s PC (Continued)

6 Enter the User ID and Password.

After clicking <Next>>, connects to the Server.

1Enter

3Click

2Enter

7 Adding the Server has completed.

Click

8 Connect the radio.

1Click

2Click

5Click

6Click

7Click

NOTE:

If you cannot connect to the Server, the error 
screen is displayed.
Click <<Back>, and confirm the settings.

(Example: USER0001)

3Select

4Select
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This section describes how to connect and remotely control a radio from a Remote station using the Remote 
Controller.
See the RS-BA1 Instruction Manual (“5. REMOTE CONTROLLER’S BASIC OPERATION” section) for details.
 • The description in this section is based on the assumption that the connection to the radio using the Remote 

Utility has succeeded (“<<Connected>>” is displayed under the radio name).

1 Connect setting using the Remote Controller

1. Double-click the “RS-BA1 Remote Control” icon on your desktop to open the Remote 
Controller.

2. Click the icon to the right in the toolbar, or click “Connect Setting...” in the [Option] menu.
3. The Connect Setting screen appears. 

Configure the connect settings as described below.
1	Select the connecting radio in the “Model” menu. 

(Example: IC-7850/IC-7851 (Ver1.10-))
2	Select “LAN” for the “Connection” item.

 • When the “MOD Select has also been changed.” dialog is displayed, click <OK>.
 • The confirmation dialog for the connection setting may be displayed, depending on the transceiver. If connected 
correctly, click <OK>.

3	Select a radio that you are accessing using the Remote Utility, in the “Remote Utility” menu. 
(Example: IC-7851abc)
 • The CI-V settings are automatically loaded from the Remote Utility to the CI-V field. The settings include 
the virtual COM Port number, radio’s CI-V address and baud rate  and the virtual audio device for the Voice 
Memory function.
 L If the desired radio is not displayed in the “Remote Utility” menu, click <Search> to load the radios’ information 
from the Remote Utility.

4	Check the “Software closing turns OFF the Radio.” box to turn OFF the radio when the Remote 
Controller is closed by clicking the <  > button or [Exit] on the File menu.
 • When the PC is shut down while the Remote Controller is still running, the transceiver’s power may not be 
turned OFF.

5	Click <OK> to save the settings and close the screen.

3Select

1Select

2Select

Step5. Remote control operation

1.  2.  3.  4.  Step5.

5Click

4Check
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2

3

Connecting to the radio using the Remote Controller

Click the icon to the right in the toolbar, or click “Connect ON” in the [File] menu, to connect to the 
radio.

 • When the connection has succeeded, the radio’s current data will be displayed on the main panel.

4

NOTE: DO NOT allow the PC to go into the sleep or standby mode while using the RS-BA1. Otherwise, it might 
not work properly after the PC resumes normal activity.

When not using the radio:

 • Disconnect the radio from both the Remote Controller and Remote Utility. 
 • If you check the “Software closing turns OFF the Radio.” box, when you close the Remote Controller, the 
radio’s power is also turned OFF. 
If you do not check the “Software closing turns OFF the Radio.” box, be sure to disconnect the radio from 
Remote Controller, first. And close the Remote Controller, and then close the Remote Utility.

 •  When you manually select the transmit audio input connector(s) to be used after finishing the Remote 
mode, right-click the icon in the toolbar, or click “Remote Setting...” in the [File] menu to select. 
-  Regularly, it automatically returns to the original setting before you start the Remote mode.

Remote control operation

See the RS-BA1 Remote Controller’s help file for remote operation details, such as how to change the 
frequency, or turn ON each function.
To display the help file, click “Contents” in the Help menu on the Remote Controller, or push the [F1] key on 
your PC’s keyboard.

Selecting a modulation input connector

In order to transmit audio when remotely controlling the radio from the Remote Controller, configure the 
following settings, depending on the radio’s connector.

1. Click [MIC SET] on the Remote Controller. 
2. The MIC SET screen appears. 

Select an appropriate connector in the “MOD Select (Remote ON)” menu (Example: LAN), to input 
transmit audio from the PC to the radio. Then, click the close button to close the screen. 

2Click

1Select

Step5. Remote control operation (Continued)

1.  2.  3.  4.  Step5.
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PREFACE

Thank you for purchasing the RS-BA1. The RS-BA1 
is designed to remotely control an Icom radio through 
a network.
This instruction manual contains detailed instructions 

on how to configure your own remote control system.
Before reading this manual, please read the RS-BA1 
Preparations that come with the RS-BA1, for details 
on how to install the software.

ABOUT THE SUPPLIED GUIDES

The titles of the supplied guides described in this 
manual differ, depending on the version of your RS-
BA1. If the “Flow chart” is supplied, refer to the 
table below to read the guides in order.

Guides in this manual Guides supplied
Preparations Installation Guide q

IMPORTANT

READ THIS INSTRUCTION MANUAL 
CAREFULLY before attempting to configure the 
software.

SAVE THIS INSTRUCTION MANUAL. This 

instruction manual contains important safety and 
operating instructions for the RS-BA1.

PRECAUTIONS

IMPORTANT! To remotely control radios using the 
RS-BA1, BE SURE that you comply with your local 
regulations.

The RS-BA1 is designed to remotely control radios 
that have a USB port (Type B/Mini-B) or LAN port*.
Proper audio communication cannot be guaranteed 
when you connect the Base station’s PC to the 
radio’s ACC socket, MIC connector, or S/P DIF jack.
* Only when using:
 • IC-7851
 • IC-7850 
 • IC-7800 (firmware version 3.00 or later)
 • IC-7700 (firmware version 2.00 or later)
 • IC-7610

Depending on your radio, a few functions or modes 
cannot be used, or you will need to update the radio’s 
firmware to operate a CW keyer, using the RS-BA1.

Depending on the PC performance (OS, environment, 
etc.), the USB audio may be interrupted, or a control 
by the PC software may get delayed.

If the CPU has a heavy load, the USB audio is easily 
interrupted.

The settings of the installed audio player application 
may be changed after connecting a radio to the PC.

For the operation of your PC and peripheral devices, 
follow the instructions provided in the manuals that 
come with the PC and peripheral devices.

All copyrights associated with this manual and all 
intellectual property rights associated with the RS-
BA1 software are held by Icom Inc.

Unauthorized reproduction or transmission of this 
manual, or any part hereof, is prohibited.

The content of this manual and the software 
associated with the RS-BA1, and the appearance of 
the RS-BA1 are all subject to change without notice.

Icom, Icom Inc. and Icom logo are registered trademarks of Icom 
Incorporated (Japan) in Japan, the United States, the United 
Kingdom, Germany, France, Spain, Russia, Australia, New 
Zealand, and/or other countries.
Microsoft and Windows are registered trademarks  of Microsoft 
Corporation in the United States, and/or other countries.
Adobe, Acrobat, and Reader are either registered trademarks of 
Adobe Systems Incorporated in the United States and/or other 
countries.

All other products or brands are registered trademarks or 
trademarks of their respective holders.

NOTE:

 • This instruction manual is based on Icom Remote 

Utility Version 2.00 and RS-BA1 Version 1.94.
 • In this manual, Microsoft® Windows® 10 Home 
and Microsoft® Windows® 10 Pro are described as 
“Windows 10.” 
Microsoft® Windows® 8.1 and Microsoft® 

Windows® 8.1 Pro are described as “Windows 
8.1.” 
Microsoft® Windows® 7 Home Premium, Microsoft® 

Windows® 7 Professional, and Microsoft® 

Windows® 7 Ultimate are described as “Windows 
7.”

The software cannot be used with “RT” versions of 
Microsoft® Windows® 8.1.
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ABOUT THIS INSTRUCTION MANUAL
To start using the RS-BA1, read this instruction manual in the following order.

PREFACE

OVERVIEW OF THE RS-BA1

ABOUT THE COMMUNICATION IN THE REMOTE CONTROL SYSTEM

1. BEFORE USING REMOTE CONTROL SYSTEM (p. 1 to 14) 

When using a transceiver without the Server PC 
function.

When using one of the following transceivers with 
the Server PC function. (As of August 2017)
 • IC-7851
 • IC-7850
 • IC-7800 (Firmware version 3.00 or later)
 • IC-7700 (Firmware version 2.00 or later)
 • IC-7610

3.  WHEN CONNECTING TO THE NETWORK 

DIRECTLY

2.  WHEN CONNECTING TO THE NETWORK 

THROUGH A PC

4. SETTING FOR A REMOTE STATION PC (p. 58 to 70) 

5. REMOTE CONTROLLER’S BASIC OPERATION (p. 71 to 76) 

6. TROUBLESHOOTING (p. 77 to 83) 

(p. i to iii) 

(p. iv) 

(p. v) 

(p. 15 to 44) (p. 45 to 57) 
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OVERVIEW OF THE RS-BA1

❍  The RS-BA1 consists of the Remote Utility, used to configure a remote control system, and the Remote 
Controller, used to send CI-V commands to a radio to remotely operate it.

❍  With the RS-BA1, you can configure a remote control system through the Internet, or a LAN.
❍  The RS-BA1 provides highly qualified audio communication between your PC and an Icom amateur radio 

through a USB port (Type B/Mini-B) or LAN port*.

 • You can also control Icom radios with an RS-232C interface.
 *  If you use the IC-7700, firmware version 2.00 or later installed, is required.
   If you use the IC-7800, firmware version 3.00 or later installed, is required.

About the remote control system
An RS-BA1 remote control system basically consists of following three components:
 • Base station (Radio and Server)
 • Network (Internet or LAN)
 • Remote station (PC)

The Remote station controls the Base station radio through the network (internet or LAN).
To control the Base station radio, the radio should be connected to the network through a PC or directly.
Most Icom radios need a PC, and use the PC as the Server to exchange CI-V commands, control command and 
audio with the Remote station through either the internet or LAN. (Fig. 1)
The radio has a built-in Network function that can be directly connected to the network. With this function, a Base 
station PC is not necessary. (Fig. 2)
The radio is remotely controlled by the Remote station PC using the Remote Controller.
See the “5. REMOTE CONTROLLER’S BASIC OPERATION” section for more details. (p. 71)

Other station Network Remote stationBase station

LANLANInternetInternet

When connecting to the network through a PC (Fig. 1) 

Or

Other station Network Remote stationBase station

IC-7851

IC-7850

IC-7800 (firmware version 3.00 or later)

IC-7700 (firmware version 2.00 or later)

IC-7610

LANLANInternetInternet

When connecting to the network directly (Fig. 2)

Routers or other devices are not shown.

Or
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ABOUT THE AUDIO COMMUNICATION IN THE REMOTE 

CONTROL SYSTEM

In the remote control system, audio is exchanged between a Base station radio and the Remote station’s PC, 
through Remote Utilities, as illustrated below.
The audio settings needed are described below.

When connecting to the network through a PC

Network

Base station’s PC

VL

Remote

Utility

VL

Remote station’s PC

Remote

Utility

Remote

ControllerRadio

Base station Remote station

When connecting to the network directly

Network

Remote station’s PC

： Receive audio ： Transmit audio

VL

Remote

Utility

Remote

Controller

Base station Remote station

IC-7851

IC-7850

IC-7800 (firmware version 3.00 or later)

IC-7700 (firmware version 2.00 or later)

IC-7610

(Radio/Server)

 D  Base station settings for audio 

communication
When connecting to the network through a PC

 • Audio level adjustment for an audio device 

(pp. 6 to 11)
 • Audio device selection (p. 29)

When connecting to the network directly

 • Audio sampling rate or audio codec setting (p. 52)

 D  Remote station settings for audio 

communication
 • Audio level adjustment for an audio device 

(pp. 6 to 11)
 • Audio device selection (p. 65)
 • Network audio quality adjustment (p. 65)
 • AF or Modulation audio volume level adjustment 
(p. 67)

 • Modulation output connector setting (p. 74)
 • Modulation level adjustment (p. 74)
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BEFORE USING REMOTE CONTROL SYSTEM1

The Windows operating system includes a Firewall setting standard. This is a security function that can prevent 
improper access to your PC from the Internet.
To let Remote Utility work properly, add it as an exception to the Firewall.

■ Firewall setting

Windows 10

Before using the remote control system, the following settings are needed.
 • Firewall setting (p. 1)
 • Volume adjustment for your audio devices (p. 6)
 • To allow access from the Internet 
(The setting is necessary only when you configure the remote control system through the Internet.) (p. 12)

1. Right-click the Windows icon on the taskbar, then 
click “Control Panel.” 

1Right-click

2Click

2. Click “System and Security.” 

Click

3. Click “Allow an app through Windows Firewall.” 

Click

 • The “Allowed applications” screen is displayed.
4. Click <Change settings>. 

Click
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2

■ Firewall setting

Windows 10 (Continued)

5. Click <Allow another app...>. 

Click

 • The “Add an app” screen is displayed.
6. Click “Remote Utility” and then click <Add>. 

1Click

2Click

 • Returns to the “Allowed applications” screen.

7. In the “Allowed apps and features” list, confirm 
that “Remote Utility” is displayed and a check 
mark is in the box, and then click <OK>. 

1Conform

2Click
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■ Firewall setting (Continued)

Windows 8.1

1. Place the mouse pointer in the bottom right 
corner of the screen.
 • The charms is displayed on the right of the screen.

Charms appear

Point the mouse pointer 
around here.

2. Click the “Settings” charm. 

Click

3. Click “Control Panel.” 

Click

 • The “Adjust your computer’s settings” screen is 
displayed.

4. Click “System and Security.” 

Click

5. Click “Allow an app through Windows Firewall.” 

Click

 • The “Allowed applications” screen is displayed.
6. Click <Change settings>. 

Click

7. Click <Allow another app...>. 

Click

 • The “Add an app” screen is displayed.
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■ Firewall setting

Windows 8.1 (Continued)

8. Click “Remote Utility” and then click <Add>. 

1Click

2Click

 • Returns to the “Allowed applications” screen.
9. In the “Allowed apps and features” list, confirm 

that “Remote Utility” is displayed and a check 
mark is in the box, and then click <OK>. 

1Confirm

2Click
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Windows 7

■ Firewall setting (Continued)

1. Click “Control Panel” in the Start menu.
 • The “Adjust your computer’s settings” screen is 
displayed.

2. Click “System and Security.” 

Click

3. Click “Allow a program through Windows 
Firewall.” 

Click

 • The “Allowed Programs” screen is displayed.
4. Click <Change settings>. 

Click

5. Click <Allow another program...>. 

Click

 • The “Add a Program” screen is displayed.

6. Click “Remote Utility” and then click <Add>. 

1Click

2Click

 • Returns to the “Allowed Programs” screen.
7. In the “Allowed programs and features” list, 

confirm that “Remote Utility” is displayed and a 
check mark is in the box, and then click <OK>. 

1Confirm
2Click
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 • When connecting to the network through a PC, the audio volume adjustment is needed for both the 
Remote and Base station PCs.

 • When connecting to the network directly, the audio volume adjustment is needed for only the Remote station PC.

Before you start using the RS-BA1, the PC’s audio volume must be set to a proper level.
When several audio devices are used, you must set each one individually.
 • Configurable items, displayed screens and terms that are used may differ, depending on your PC.

When setting for the Base station PC

Adjust the audio volume input or output level from or to your radio.
In the “Playback devices” menu, you can adjust the modulation level sent to the radio.
In the “Recording devices” menu, you can adjust the audio input level from the radio.
Before adjusting, connect the radio and your PC, and turn ON the radio. (See page 16.)

When setting for the Remote station PC

Adjust the volume level of the audio device that is connected to the PC.
In the “Playback devices” menu, you can adjust the output level of the speaker or headset.
In the “Recording devices” menu, you can adjust the modulation level sent to the radio.

■ Volume adjustment for your audio devices

1. Right-click the speaker icon on the taskbar, then 
click “Playback devices” or “Recording devices.” 

2. The “Sound” screen appears, then click the 
<Playback> tab. 
In the list that appears, select the audio device 
that you will use, then click <Properties>. 

q Click

w Select

e Click

3. The “Speaker Properties” screen appears, then 
confirm “Use this device (enable)” is displayed in 
the Device Usage menu on the <General> tab. 

q Click

w Confirm

4. Click the <Levels> tab. 
Adjust the speaker’s audio level by moving the 
slide control to the right or left.
 • If the mute setting is turned ON in “Speakers” ( ), 
click the icon to turn OFF.

q Right-click

w Click

Windows 10

 ☞ Continued on the next page.
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5. After adjusting, click <OK> to close “Speaker 
Properties.” 

q Click

e Click

w Adjust

6. Click the <Recording> tab on “Sound.” 
In the list that appears, select the audio device 
that you will use, and then click <Properties>. 

q Click

w Select

e Click

7. The “Microphone Properties” screen appears, 
then confirm “Use this device (enable)” is 
displayed in the Device Usage menu on the 

<General> tab. 

q Click

w Confirm

8. Click the <Listen> tab. 
If a check mark is inserted in “Listen to this 
device,” click to remove it. 

9. Click the <Levels> tab. 
Adjust the microphone’s audio level by moving 
the slide control to the right or left.
 • If the mute setting is turned ON in “Microphone”  
( ), click the icon to turn OFF.

10. After adjusting, click <OK> to close “Microphone 
Properties.” 

q Click

w Confirm

q Click

w Adjust

e Click

Windows 10 (Continued)

■ Volume adjustment for your audio devices
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1. Right-click the speaker icon on the taskbar, then 
click “Playback devices” or “Recording devices.” 

q Right-click

w Click

2. The “Sound” screen appears, then click the 
<Playback> tab. 
In the list that appears, select the audio device 
that you will use, then click <Properties>. 

q Click

w Select

e Click

3. The “Speaker Properties” screen appears, then 
confirm “Use this device (enable)” is displayed in 
the Device Usage menu on the <General> tab. 

q Click

w Confirm

4. Click the <Levels> tab. 
Adjust the speaker’s audio level by moving the 
slide control to the right or left.
 • If the mute setting is turned ON in “Speakers” ( ), 
click the icon to turn OFF.

5. After adjusting, click <OK> to close “Speaker 
Properties.” 

q Click

e Click

w Adjust

Windows 8.1

 ☞ Continued on the next page.

■ Volume adjustment for your audio devices (Continued)
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6. Click the <Recording> tab on “Sound.” 
In the list that appears, select the audio device 
that you will use, and then click <Properties>. 

q Click

w Select

e Click

7. The “Microphone Properties” screen appears, 
then confirm “Use this device (enable)” is 
displayed in the Device Usage menu on the 

<General> tab. 
q Click

w Confirm

8. Click the <Listen> tab. 
If a check mark is inserted in “Listen to this 
device,” click to remove it. 

q Click

w Confirm

9. Click the <Levels> tab. 
Adjust the microphone’s audio level by moving 
the slide control to the right or left.
 • If the mute setting is turned ON in “Microphone”  
( ), click the icon to turn OFF.

10. After adjusting, click <OK> to close “Microphone 
Properties.” 

q Click

w Adjust

e Click

Windows 8.1 (Continued)

■ Volume adjustment for your audio devices
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1. Right-click the speaker icon on the taskbar, and 
click “Playback devices” or “Recording devices.” 

w Click

q Right-click

2. The “Sound” screen appears, then click 
<Playback>. 
In the list that appears, select the audio device 
that you will use, and then click <Properties>. 

q Click

w Select

e Click

3. The “Speaker Properties” screen appears, then 
confirm “Use this device (enable)” is displayed in 
the Device Usage menu on the <General> tab. 

q Click

w Confirm

4. Click the <Levels> tab. 
Adjust the speaker’s audio level by moving the 
slide control to the right or left.
 • If the mute setting is turned ON in “Speakers” ( ), 
click the icon to turn OFF.

5. After adjusting, click <OK> to close “Speaker 
Properties.” 

q Click

w Adjust

e Click

Windows 7

■ Volume adjustment for your audio devices (Continued)
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6. Click the <Recording> tab on “Sound.” 
In the list that appears, select an audio device 
that you will use, then click <Properties>. 

q Click

w Select

e Click

7. The “Microphone Properties” screen appears, 
then confirm “Use this device (enable)” is 
displayed in the Device Usage menu on the 

<General> tab. 

q Click

w Confirm

8. Click the <Listen> tab. 
Confirm that a check mark is not inserted in 
“Listen to this device.” 

q Click

e Click

w Confirm

9. Click the <Levels> tab. 
Adjust the microphone’s audio level by moving 
the slide control to the right or left. 
After adjusting, click <OK> to close “Microphone 
Properties.”
 • When the mute setting is turned ON in “Microphone”  
( ), click the icon to turn OFF.

 

q Click

e Click

w Adjust

NOTE:

If you use “USB Audio CODEC” as the audio device, 
set the audio level to 2. Setting the level to 3 or 
higher can distort the audio.

Windows 7 (Continued)

■ Volume adjustment for your audio devices
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 LOnly when you configure the remote control system through the Internet, you need the following settings on 
your router.

If you configure the remote control system through the Internet, whether you are operating as a Base station or a 
Remote station, you need to configure your router to allow access from the Internet.
To allow the access, configure the 3 port numbers used with the Remote Utility (Example: 50001 to 50003).
Ask the router’s manufacturer about how to forward the port.

When connecting to the network through a PC

INTERNETINTERNET

IP Adress:

192.168.0.100

IP Adress:

192.168.0.100

Router Router

Icom radio Base station Remote station

Default Gateway:

192.168.0.1

DNS Server Address:

192.168.0.1

Default Gateway:

192.168.0.1

DNS Server Address:

192.168.0.1

Port numbers

50001 to 50003

Port numbers

50001 to 50003

When connecting to the network directly

IC-7851

IC-7850

IC-7800 (firmware version 3.00 or later)

IC-7700 (firmware version 2.00 or later)

IC-7610

(Radio/Server) 

INTERNETINTERNET

IP Adress:

192.168.0.100

Router Router

Remote station

Default Gateway:

192.168.0.1

DNS Server Address:

192.168.0.1

Default Gateway:

192.168.0.1

Port numbers

50001 to 50003

Port numbers

50001 to 50003

IP Adress:

192.168.0.10

■ To allow access from the Internet
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When connecting to the network through a PC

PC (Remote Utility) setting

1. Enter the fixed IP address, if you use DHCP.
2. Enter the default gateway and DNS server 

address of the router.
3. After setting, start the WWW browser to confirm 

you can access the internet.

Router setting

Please refer to your router’s manual for details of how 
to configure the settings.

When connecting to the network directly

Radio setting

 • Except for the IC-7610

1. Hold down [EXIT/SET] for 1 second to select the 
Set mode menu screen.

2. Push [OTHERS](F-5) to enter the Miscellaneous 
(Others) set mode.
 • For the IC-7800 and IC-7700, go to step 5.

3. Push [▲](F-1) or [▼](F-2) to select “DHCP.”
4. Rotate the main dial to select “OFF.” 

Select

5. Push [▲](F-1) or [▼](F-2) to select “IP Address.”
6. Push [◀▶](F-3) to select the desired part, then 

rotate the main dial to set the fixed IP address. 
(Example: 192.168.0.10) 

Set

7. Push [▲](F-1) or [▼](F-2) to select “Default 
Gateway.”

8. Push [◀▶](F-3) to select the desired part, then 
rotate the main dial to set the default gateway of 
the router. (Example: 192.168.0.1) 

Set

9. Reboot the radio. 

The settings will take effect after rebooting.

■ To allow access from the Internet (Continued)
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When connecting to the network directly
Radio setting (Continued)
 • For the IC-7610

1. Push [MENU] to display the MENU screen.
2. Touch [SET] to enter the Set mode.
3. Touch [Network].
4. Touch “DHCP.”
5. Touch “OFF.” 

6. Touch “IP Address.”
7. Enter the fixed IP address.  

(Example: 192.168.0.10) 

Enter

8. Touch “Default Gateway.”
9. Set the default gateway of the router. 

(Example: 192.168.0.1) 

Enter

10. Reboot the radio. 

The settings will take effect after rebooting.

■ To allow access from the Internet

Router setting

Please refer to your router’s manual for details of how 
to configure the settings.
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WHEN CONNECTING TO THE NETWORK THROUGH A PC2

If you are using one of the following radios, skip this section and go to section 3. (p. 45)

 • IC-7851
 • IC-7850
 • IC-7800 (Firmware version 3.00 or later)
 • IC-7700 (Firmware version 2.00 or later)
 • IC-7610 (As of August 2017)

This section describes about the Base staion’s settings when connecting to the network through a PC.

 ■ Connecting the radio to the Base station’s PC ................................................................................................................... 16
DSelect the connection pattern .......................................................................................................................................... 16
DWhen connecting to the radio’s [USB] port ...................................................................................................................... 17
DWhen connecting to the radio’s [REMOTE] jack .............................................................................................................. 18
DWhen connecting to the radio’s [RS-232C] port ............................................................................................................... 19

 ■ Radio’s presetting ............................................................................................................................................................... 21
DThe following manual settings are required when operating the RS-BA1 ........................................................................ 21
DThe following settings are automatically set to the radio ................................................................................................. 22

 ■ Setting your PC’s environment ........................................................................................................................................... 23
 ■ Radio registration ................................................................................................................................................................ 24
DTo register a radio ............................................................................................................................................................ 24
DTo change a radio properties ........................................................................................................................................... 29
DTo delete a radio .............................................................................................................................................................. 29

 ■ User registration.................................................................................................................................................................. 30
DTo add a user ................................................................................................................................................................... 31
DTo allow a user to use a radio .......................................................................................................................................... 32
DTo inhibit a user to use a radio ......................................................................................................................................... 32
DTo change a user properties ............................................................................................................................................ 33
DTo delete a user ............................................................................................................................................................... 33

 ■ To monitor, or disconnect a Remote station ........................................................................................................................ 34
DTo monitor the received or transmitted audio ................................................................................................................... 34
DTo terminate a connection ................................................................................................................................................ 35

 ■ Connecting to a radio from the Server ................................................................................................................................ 36
DConnecting to a radio ....................................................................................................................................................... 36
DDisconnecting from a radio .............................................................................................................................................. 37

 ■ Confirming Server Address or Network Name .................................................................................................................... 38
DWhen configuring the remote control system through a LAN .......................................................................................... 38
DWhen configuring the remote control system through the Internet .................................................................................. 43
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■ Connecting the radio to the Base station’s PC

Before connecting the radio to the PC, please finish the installation for the Base station's PC and the Remote 
station's PC, using the RS-BA1 Preparations.

Check the connector type on your radio and see the following chart to connect your radio to the Base station’s 
PC.
To connect an Icom CI-V command capable radio to the Base station’s PC, you have to make connections for 
control command and audio communication.

RS-BA1 operation with the Base station’s PC connected to the radio’s ACC socket, MIC connector, or S/P DIF 
jack for audio communication cannot be guaranteed.

Radio's connector
Outline

Model Ref.
Control command Audio

When connecting 

to the radio's [USB] 

port

Through a USB cable

IC-7100/IC-7200/
IC-7300/IC-7410/
IC-7600*1/IC-
7610/IC-7850/IC-
7851/IC-9100

p. 17

When connecting 

to the radio's 

[REMOTE] jack

Through the 

CT-17 ci-v level 

converter

Through an audio cable connected 

between the PC’s audio terminal 

and the radio’s [ACC] socket or 
[MIC] connector

All p. 18

When connecting 

to the radio's [RS-

232C] port

Through an RS-

232C cable

Through an audio cable connected 

between the PC’s audio terminal 
and the radio’s [ACC] socket, [MIC] 
connector or [S/P DIF] jack

IC-7700/IC-7800*2 p. 19

 DSelect the connection pattern

*1 When you turn your radio ON or OFF from the Remote Controller, connect to the radio's [Remote] jack.
*2  When you turn your radio ON or OFF from the Remote Controller, connect to the radio's [Remote] jack or to 

the network directly.
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■ Conncting the radio to the Base station’s PC (Continued)

 DWhen connecting to the radio’s [USB] port

1. System requirements

 • A PC that has a USB 1.1, 2.0, or 3.0 port
 • Icom CI-V command capable radio that has a [USB] 
port (Type B/Mini-B)

 • The USB cable (supplied to the RS-BA1 or a radio)

2. Install a USB driver

CAUTION:

•  NEVER connect the radio to the PC with the USB 

cable until the USB driver installation has been 

completed.

•  The driver is not supported by the Windows® auto-

matic recognition system.

To use the USB cable between the radio and the PC, 

you must first install a USB driver.

•  The USB driver comes with the RS-BA1. Or down-

load from the Icom website.

NOTE: When a PC with USB 3.0 port is used for 

operating the radio, confirm the driver name. If the 

name “Silicon Laboratories CP210x USB to UART 

Bridge (Driver Removal)” is displayed on the 

Control Panel screen, uninstall it and then install 

the latest driver.

The latest driver and installation guide can be down-

loaded from here:

     http://www.icom.co.jp/world/index.html

Read the installation guide before installing the driver.

3. Connect the radio to the Base station’s PC

Connect the radio to the Base station’s PC using the 
USB cable.
 • This guide is based on using a Type B USB cable.

USB cable

Radio

(Rear panel)

PC

To the USB port

To a USB port

ACC

KEY1 2 METER REMOTE

NOTE: If you connect a new USB audio device to 

your PC, the device selected as the default on 

your PC can be changed. Moreover, never con-

nect another radio using a USB cable while the 

Remote Utility is open.

For IC-7600 users
When you turn your radio ON or OFF from the Remote Controller, connect to the radio's [Remote] jack.
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■ Conncting the radio to the Base station’s PC (Continued)

1. System requirements

 • A PC that has an RS-232C port

 • Icom CI-V command capable radio that has a 

[REMOTE] jack

 • The optional CT-17 ci-v level converter 

(Two mini-plug cables are included.)

 • An RS-232C cable (purchase separately)

 • Stereo audio cables (purchase separately)

2. Connect a remote control system

Connect the CT-17 to the base station’s PC, which 

enables the CI-V communication between them.

ct-17

Radio

PC

Mini-plug cable

To an RS-232C port

9–15V DC

To the RS-232C port

RS-232C cable*

3. Connect an audio system

Connect an audio cable between the PC’s audio port 

and the radio’s [ACC] socket or [MIC] connector to 

enable audio communication between them.

See the radio’s instruction manual for details on the 

connector.

Radio   PC

AF (Output)  LINE IN/MIC IN (Input)

MOD (Input)  LINE OUT (Output)

 DWhen connecting to the radio’s [REMOTE] jack

•  When using the [MIC] connector, NEVER 

directly connect an audio cable between the 

radio’s Microphone input and PC. It can cause 

a malfunction without adding the Electrolytic 

capacitor, as illustrated above.

•  NEVER connect a monaural plug to the PC’s 

LINE OUT. It can cause a malfunction.

（Rear panel view）
• Connect to the [ACC] socket

• Connect to the [MIC] 

   connector

（Front panel view）

（Rear panel view）

IC-7600 type (8 pin)

1

2

3

4 5

6 7

8

AF

MOD

IC-7000 type (13 pin)

1 2 3 4

8765

9 10 11 12

13

MOD

AF

IC-7600 type (8 pin)

y 

IC-7000 type (Modular)

1

2

3
4

5

6

7

8

AF output

i q

PC

GND

MOD
Not used

GND

GND

GND

t

Connect to the

PC’s LINE OUT

GND

AF
Not used

Connect to the

PC’s LINE IN or 

MIC IN

Microphone 

input

Microphone 

input

MIC E

10 µF/16 V

+

10 µF/16 V

+

* CT-17 accepts only an RS-232C cable. The use of an 

RS-232C-USB converter is not guaranteed.
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 DWhen connecting to the radio’s [RS-232C] port

1. System requirements

 • A PC that has an RS-232C port
 • Icom CI-V command capable radio that has an  
[RS-232C] port

 • An RS-232C cable (purchase separately)
 • Two S/P DIF digital cables or stereo audio cables 

(purchase separately)

2. Connect a remote control system

Connect an RS-232C cable between the radio and 
the base station’s PC.

PC

MAINSUBACC 1ACC 2ACC 1ACC 2INOUTRS-232C

ABS/P DIF EXT-SP

Radio (Rear panel)

To an RS-232C port

RS-232C cable

To the [RS-232C] port

For IC-7800 users
When you turn your radio ON or OFF from the Remote Controller, connect to the radio's [Remote] jack or to the 
network directly.

■ Conncting the radio to the Base station’s PC (Continued)
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 D When connecting to the radio’s [RS-232C] port (Continued)

■ Conncting the radio to the Base station’s PC

3. Connect an audio system

Connect an audio cable between the PC’s audio port 

and the radio’s [S/P DIF] jack, [ACC] socket or [MIC] 

connector to enables audio communication between 

them.

See the radio’s instruction manual for details on the 

radio’s connector.

• Using the [S/P DIF] jack

Radio   PC

S/P DIF OUT (Output)  S/P DIF IN (Input)

S/P DIF IN (Input)  S/P DIF OUT (Output)

PC

MAINSUBACC 1ACC 2ACC 1ACC 2INOUTRS-232C

ABS/P DIF EXT-SP

S/P DIF digital

cable

Radio (Rear panel)

• Using other than the [S/P DIF] jack

Radio   PC

AF (Output)  LINE IN/MIC IN (Input)

MOD (Input)  LINE OUT (Output)

（Rear panel view）
• Connect to the [ACC] socket

• Connect to the [MIC] 

   connector

（Front panel view）

1

2

3

4 5

6 7

8

AF

MOD

1

2

3
4

5

6

7

8

AF output

PC

GND

MOD
Not used

GND

GND

Connect to the

PC’s LINE OUT

GND

AF
Not used

Connect to the

PC’s LINE IN or 

MIC IN

Microphone 

input
10 µF/16 V

+

•  When using the [MIC] connector, NEVER 

directly connect an audio cable between the 

radio’s Microphone input and PC. It can a 

cause malfunction without adding the 

Electrolytic capacitor, as illustrated above.

•  NEVER connect a monaural plug to the PC’s 

LINE OUT. It can cause a malfunction.
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■ Radio’s presetting

The RS-BA1 remotely controls Icom radios using CI-V (Icom Communication Interface) commands. See the CI-V 
command table in the radio’s instruction manual for details of the functions that can be controlled.

 DThe following manual settings are required when operating the RS-BA1
Properly preset the items in below table for functions that cannot be controlled by CI-V commands or the item 
may cause unwanted actions. See the radio’s instruction manual for details of the settings or operation.
NOTE: 

 • Remove the transverter from the radio, if it is connected.
 • To prevent an accidental transmission, we recommend you remove any keyer, keypad or other external 
equipment connected to the radio.

 • Set the radio to a normal operating mode. The radio cannot receive CI-V commands while in special modes, 
such as the firmware update mode or cloning mode.

 • If the radio has a Time-Out Timer function, we recommend you enable it to prevent the radio from continuously 
transmitting.

Genre Item Model Setting

Function RIT function All Set to OFF.
∂TX function All Set to OFF.
Simple band scope IC-746PRO*/IC-7000*/IC-7100/

IC-7400*/IC-9100
Set to OFF.

SWR Measurement function IC-746PRO*/IC-7000*/IC-7100/
IC-7400*/IC-9100

Set to OFF.

Timer/Sleep Timer function Radios with the timer function Set the timer to OFF or to your 
schedule.

Weather Alert function IC-7100 Set to OFF.
Display RTTY decode screen IC-746PRO*/IC-756PROIII*/IC-7400* Exit the screen.
Volume Volume for the RX audio All Set the volume to a suitable level.

CI-V CI-V address All Set an appropriate CI-V address.
CI-V baud rate All Set to 19200 bps (or Auto).
CI-V USB Port IC-7300/IC-7610/

IC-7850 (Firmware version 1.10 or later)/
IC-7851 (Firmware version 1.10 or later)

To use the Scope function when 
connecting to the USB port, set to 
Unlink from [REMOTE].

CI-V USB Baud Rate IC-7300/IC-7610/
IC-7850 (Firmware version 1.10 or later)/
IC-7851 (Firmware version 1.10 or later)

To use the Scope function when 
connecting to the USB port, set to 
115200 (or Auto).

Set mode USB Serial Function Radios with a USB (B type) port Set to “CI-V” for the selected 
connection type.

RS-232C Function Radios with an RS-232C port Set to “CI-V” for the selected 
connection type.

* Operation on models without a USB connection cannot be guaranteed.

If you are using the IC-PW1 with the transceiver, be sure to set the CI-V baud rate to 19200 bps. After changing 
the transceiver’s CI-V settings, be sure to reset the CPU of the IC-PW1 and set the transceiver’s CI-V settings 
on the IC-PW1. See the IC-PW1 instruction manual for details.
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■ Radio’s presettings (Continued)

 DThe following settings are automatically set to the radio

When the RS-BA1’s Remote Controller connects to the radio, and you select the model name on the Connect 
Setting screen, the following may be automatically set, depending on the model. When you manually operate the 
radio, set these items as desired.

Genre Item Model Action

Function MAIN/SUB Tranking function IC-7610/
IC-7850 (Firmware version 1.10 or later)/
IC-7851 (Firmware version 1.10 or later)

Automatically set to OFF.

RIT function Radios with the Network function/
IC-7100 (Firmware version 1.10 or later)/
IC-7600 (Firmware version 2.00 or later)

Automatically set to OFF.

∂TX function Radios with the Network function/
IC-7600 (Firmware version 2.00 or later)

Automatically set to OFF.

SSB/CW Synchronous 
Tuning

All Automatically set to OFF.

Calibration Marker Radios with Calibration Marker function Automatically set to OFF.
VOX function All Automatically set to OFF.
Scan function All Automatically cancel the scan.
RTTY filter IC-746PRO*/IC-756PROIII*/IC-7400* Automatically set to OFF.
Twin Peak Filter IC-746PRO*/IC-756PROIII*/IC-7400* Automatically set to OFF.

Display Dualwatch function Radios with the Dualwatch function Automatically set to OFF.
SUB band IC-9100 Automatically set to OFF.
Memory channel/Call 
channel

All Automatically set to the VFO mode.

Operating 

mode

DR (D-STAR® REPEATER) 
mode 

Radios with the DV mode Automatically set to OFF.

Satellite mode Radios with the Satellite mode Automatically set to OFF.
CI-V CI-V transceive All Automatically set to ON.

CI-V 731 Mode IC-746PRO*/IC-756PROIII*/IC-7400* Automatically set to OFF.

*  Operation on models without a USB connection cannot be guaranteed. 
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Configure your PC’s environment in the Base station’s Remote Utility.
The settings will take effect after rebooting the Remote Utility.
When you first open the Remote Utility, the Settings screen appears.
After configuring the settings, you can display other setting screens.

■ Setting your PC’s environment

1. Click “Options.”
2. Click “Settings.”

 • The “Settings” screen is displayed.
3. Configure the settings.
4. Click <OK> to save the settings.

 • The “Take effect after restarting the application” 
screen is displayed.

5. Click <OK>. 
The settings will take effect after rebooting the 
Remote Utility.

1Click

2Click

3Set

4Click

5Click

1

2

3

4

1	PC Name

 Enter a name for your PC of up to 16 characters.
 DO NOT use the same name for more than one PC on your network.

2	Port numbers

 Enter the port numbers of the Control, Serial, and Audio port.
 You should use the default port numbers for these ports.

3	Internet Access Line

 Select your internet access line type.

4	Language

 Select the software display language.
 The selected language will be used as the Help file language.

NOTE:

If you configure the remote control system through the Internet, and change the port number of the Control, 
Serial or Audio port, you should configure the port forwarding settings and the IP filter settings on your router 
once again. (p. 12)
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In the Base station’s Remote Utility, register the radios that are physically connected to your PC.
See page 16 to connect a radio to your PC.

■ Radio registration

Registered Radio List screen

1. Click “Options.”
2. Click “Local/Server Settings.”

 DTo register a radio
Procedure

1Click

2Click

Step 1:

Open the Register a Radio screen.
Registered Radio List screen  <Add>

Step 2:

Select the purpose of use of the radio.

Step 3:

Select a radio.

Step 4:

Set the CI-V/COM port settings.

Step 5:

Set the audio of the radio.

Step 6:

Register a User to accept connection.

Step 7:

Enter the radio name.

Step 8:

The registration of the radio is completed.

NOTE:

When you register a radio from the Setup Wizard screen, click Setup for a Server PC (The radio is 

accessible by Remote PC(s).). (Installtion guide A Step4.)
 LTo display the Setup Wizard screen, click Setup Wizard on the top menu.
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■ Radio registration

 D To register a radio (Continued)

1 Open the Register a Radio screen.

Click <Add> to display the Register a Radio 
screen.

Click

2 Select the purpose of use of the radio.

 L If you register a radio by the Setup Wizard 
screen, this screen is not displayed.

1. Select “Accessible from other PCs.
 L If you select “Only accessible from this PC,” 
the radio is not accessible from other PCs.

2. Click <Next>>.
1Select

2Click

3 Select a Radio.

1. Select a Radio that you want to add.
 • USB 

Select if the radio is connected to the PC using 
a USB cable. 
Select the connected radio from the drop-down 
list. 

L�If the radio is not listed, click the <Search> 
button.

 • Manual 

Select if the radio is connected to the PC using 
other than a USB cable. 
Select the connected radio from the drop-down 
list.

2. Click <Next>>.

1Select

2Click
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■ Radio registration

 D To register a radio (Continued)

4 Set the CI-V/COM port settings.

1. Set the CI-V address, Baud rate, and COM 
Port Number.

 L If you select “USB” in Step.3, they are no 
necessary changes.

2. Click <Next>>.

1Set

2Click

5 Set the audio of the Radio.

 LThis screen is displayed if you select 
“Manual” in Step.3.

1. Select an audio device that input a received 
audio from the radio from the AF Input 
Device drop-down list.

2. Select an audio device that output a 
modulation to the radio from the MOD 
Output Device drop-down list.

3. Click <Next>>. 3Click

1Select

2Select
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■ Radio registration

 D To register a radio (Continued)

6 Register a User to accept connection.

1. Click <Add>.
2. Enter a user ID of up to 16 characters, case-

sensitive.
 L You cannot register an already registered ID.

3. Enter a password, of 8 to 16 characters, 
case-sensitive.

 L At least two different characters must be used.
4. Click <OK>.
5. Select the user.

6. Click <Add>>>.
7. Click <Next>>.

1Click

2Enter

3Enter

4Click To set the user as 

an administrator, 
click to make a 
check mark.

5Click 6Click

7Click

To prevent unauthorized access:

Set a long and strong password so that no one can 
possibly guess it.
Mix upper and lower case letters, numbers or 
characters.
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■ Radio registration

 D To register a radio (Continued)

7 Enter the radio name.

1. Enter the radio name.
 L The radio’s model name and the last 5 figures 
of the serial number is entered by default.

2. Click <Next>>.

2Click

8 The registration of the Radio is completed.

Click <Finish>.

Click

By connecting the Radio to a USB port, the 
default settings on the REC/PLAY device 
window may change to the Radio’s Speaker 
and Microphone. To confirm the settings, click 
the <Sound Settings> button.

1Enter
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■ Radio registration (Continued)

 DTo change a radio properties

Options > Local/Server Settings > Registered Radio List

1. Select a radio.

2. Click <Properties>.
3. Change the settings, and then click <OK>.

1Click

2Click

 DTo delete a radio

Options > Local/Server Settings > Registered Radio List

1. Select a radio.

2. Click <Delete>.

1Click

2Click
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In the Base station’s Remote Utility, register users (Remote Stations) to allow them to access the Server.
The Server verifies the user ID and password when users attempt to access the Server. If the User ID or 
password is incorrect, the Remote station cannot access the Server.

■ User registration

User Management screen

1. Click “Options.”
2. Click “Local/Server Settings.”
3. Click the <User Management> tab.

1Click

2Click

3Click
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To prevent unauthorized access:

Set a long and strong password so that no one can 
possibly guess it.
Mix upper and lower case letters, numbers or 
characters.

■ User registration (Continued)

 DTo add a user

Options > Local/Server Settings > User Management List

1. Click <Add>.
2. Enter a user ID of up to 16 characters, case-

sensitive.
 L You cannot register an already registered ID.

3. Enter a password, of 8 to 16 characters, case-
sensitive.

 L At least two different characters must be used.
4. Click <OK>.

1Click

2Enter

3Enter

4Click To set the user as 

an administrator, 
click to make a 
check mark.
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■ User registration (Continued)

 DTo allow a user to use a radio

Options > Local/Server Settings > User Management List

1. Select a radio that you allow the user to use.
2. Select the user.

3. Click <Add>>>.
1Select

2Select

3Click

 DTo inhibit a user to use a radio

Options > Local/Server Settings > User Management List

1. Select a radio that you inhibit the user to use.
2. Select the user.

3. Click <<<Delete>.
1Select

2Select

3Click
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■ User registration (Continued)

 DTo change a user properties

Options > Local/Server Settings > User Management List

1. Select a user.

2. Click <Properties>.
3. Change the settings, and then click <OK>.

1Select

2Click

 DTo delete a user

Options > Local/Server Settings > User Management List

1. Select a user.

2. Click <Delete>.

1Select

2Click
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When you are operating as a Base station, and a Remote station is accessing a radio that is physically connected 
to your PC, you can monitor the received and transmitted audio.

 LTo monitor, you should connect a speaker to your PC.
Moreover, you can terminate the connection between the Remote station and the radio.
Besides Base stations, administrator Remote stations can also terminate a connection between another Remote 
station and a radio.

■ To monitor, or disconnect a Remote station

1. In the Base station’s Remote Utility, click the 
<Radio List> tab.

2. Select a radio with “Busy” under its name. 
The operating user’s name (PC Name that 

the Remote station set in the Network Setting 
screen), and its IP address are displayed under 
“Busy.”

3. Click <Monitor> to display the Monitor screen.
4. Click <TX Monitor> to turn the Transmit Monitor 

function ON or OFF. 
Click <RX Monitor> to turn the Receive Monitor 
function ON or OFF. 
Slide the adjustment bar on the Volume field up 
or down to adjust the monitoring audio volume 
level. 

5. Click <Close> to close the screen.

 DTo monitor the received or transmitted audio

1Click

2Select

1Click

2Adjust

3Click

3Click
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■ To monitor, or disconnect a Remote station (Continued)

 DTo terminate a connection
1. In the Base station’s or in the administrator 

Remote station’s Remote Utility, click the <Radio 
List> tab.

2. Select a radio with “Busy” under its name. 
The operating user’s name (PC Name that 

the Remote station set in the Network Setting 
screen), and its IP address are displayed under 
“Busy.”

3. Click <Disconnect>.
 • “The radio is in use by a Remote PC. Do you want to 
disconnect?” is displayed.

4. Click <Yes> to terminate the connection.
 L When you terminate a connection, no dialog 
appears on the disconnected Remote station’s 
Remote Utility.

1Click

2Select

3Click

4Click
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When you are operating as a Base station, you can access a radio which is physically connected to your PC 
(Server).

 LFor audio communication, you should connect a speaker and microphone, or headset to your PC.
 LTo control the radio, connect to it using a control software.

■ Connecting to a radio from the Server

 DConnecting to a radio
1. In the Base station’s Remote Utility, click the 

<Radio List> tab.
2. Select a radio which is physically connected to 

your PC (Server).
3. Click <Connect>.

 • A dialog showing a port number, which is used to 
exchange CI-V commands between your PC and a 
radio, is dispalyed.

4. Click <OK> to access the radio.
 • “<<Connected>>” is displayed under the radio name 
when the connection has succeeded.
 L When you connect to the radio using a control 
software, you have to set the port number shown 
above.

1Click

2Select

3Click

4Click

TIP: When you change the radio settings,
1. In the Base station’s Remote Utility, click the 

<Radio List> tab.
2. Select a radio which is physically connected to 

your PC (Server).
3. Click <Settings>.

 L Radios that are connected with the Remote Utility 
of the Server PC, the Connection Setting cannot be 
changed.

4. Select an audio device in the Speaker menu to 

which your speaker is connected.
 • Radio’s received audio will be heard from the 
device.

5. Select the audio device in the Mic menu to 

which your microphone is connected.
 • You can input transmit audio in the device to send to 
the radio.

6. Click <OK> to save the settings.

1Click

2Select

3Click

6Click

4Select

5Select



2 WHEN CONNECTING TO THE NETWORK THROUGH A PC

37

 DDisconnecting from a radio
1. In the Base station’s Remote Utility, click the 

<Radio List> tab.
2. Select a radio with “<<Connected>>” under its 

name.

3. Click <Disconnect>.
 • “Do you want to disconnect the radio?” is displayed

4. Click <Yes> to disconnect the radio.

■ Connecting to a radio from the Server (Continued)

NOTE:

Be sure to disconnect from the radio when not 
using it. Otherwise, other Remote stations cannot 
connect to it.

1Click

2Select

3Click

4Click
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 DWhen configuring the remote control system through a LAN
If you configure the remote control system through a LAN, Remote stations can access the Server using its 
computer name or IP address. 
The example below describes how to find out the PC (Server)’s computer name, or IP address, to be requested 
by Remote stations.

When you configure the remote system, Remote stations can access the Server using its IP address, computer 
name, network name, or domain name.

IP address: 192.168.0.10

Computer name: Base PC

PC

Icom radio

PC

(Server)

Request “192.168.0.10”(IP address)

or “Base PC”(Computer name)

Router
Base station Remote station

To let Remote stations access the Server using its computer name

A computer name is used on networks to identify a particular workstation on the network.
Find out your PC’s computer name to let Remote stations access the Server using it.

1. Click the folder icon on the taskbar. 

2. Right-click “This PC,” and then click “Properties.” 

3. The “System” screen appears, then confirm the 
name that is displayed in the Computer name 

field. Click

Right-click

Click

Confirm

Windows 10

■ Confirming Server Address or Network Name
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■ Confirming Server Address or Network Name

 D When configuring the remote control system through a LAN

To let Remote stations access the Server using its computer name (continued)

1. Click the folder icon on the taskbar. 

Click

2. Right-click “PC,” and then click “Properties.” 

q Right-click

w Click

3. The “System” screen appears, then confirm the 
name that is displayed in the Computer name 

field. 

Confirm

Windows 8.1

1. Right-click [Computer] in the <Start> menu, and 
then click [Properties]. 

q Click

w Right-click 

e Click

2. The “System” screen appears, then confirm the 
name that is displayed in the Computer name 

field. 

Confirm

Windows 7
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To let Remote stations access the Server using its IP address

An IP address is a numerical label that is assigned to devices participating in a computer network.
Find out your PC’s IP address to let Remote stations access the Server using it.

1. Right-click the Network icon on the taskbar, and 
then click [Open Network and Sharing Center]. 

2. The “Network and Sharing Center” screen 
appears, then click [Ethernet]. 

3. The “Ethernet Status” screen appears, then click 
<Details...>. 

4. The “Network Connection Details” screen 
appears, then confirm the IP address that is 
displayed in the Address field. 
Click <Close> to close the window. 
 

When the DHCP Enabled field is set to “Yes” 
in the “Network Connection Details” screen, the 
DHCP server assigns a dynamic IP address to 
your PC.
Because of this, Remote stations will have to 
match the IP address each time to access the 
Server.
If the DHCP Enabled field is set to “Yes,” 
we recommend that you let Remote stations 
access the Server using its computer name. (p. 
38)

q Right-click

w Click

Click

Click

q Confirm

w Click

Windows 10

■ Confirming Server Address or Network Name

 D When configuring the remote control system through a LAN (continued)
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1. Right-click the Network icon on the taskbar, and 
then click [Open Network and Sharing Center]. 

q Right-click

w Click

2. The “Network and Sharing Center” screen 
appears, then click [Ethernet]. 

Click

3. The “Ethernet Status” screen appears, then click 
<Details...>. 

Click

4. The “Network Connection Details” screen 
appears, then confirm the IP address that is 
displayed in the Address field. 
Click <Close> to close the window. 

q Confirm

w Click

 

When the DHCP Enabled field is set to “Yes” 
in the “Network Connection Details” screen, the 
DHCP server assigns a dynamic IP address to 
your PC.
Because of this, Remote stations will have to 
match the IP address each time to access the 
Server.
If the DHCP Enabled field is set to “Yes,” 
we recommend that you let Remote stations 
access the Server using its computer name. (p. 
38)

Windows 8.1

■ Confirming Server Address or Network Name

 D When configuring the remote control system through a LAN

To let Remote stations access the Server using its IP address (continued)
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1. Right-click the Network icon on the taskbar, and 
then click [Open Network and Sharing Center].

q Right-click

w Click

2. The “Network and Sharing Center” screen 
appears, then click [Local Area Connection].

Click 

3. The “Local Area Connection Status” screen 
appears, then click <Details...>.

Click 

4. The “Network Connection Details” screen 
appears, then confi rm the IP address that is 
displayed in the Address fi eld.
Click <Close> to close the window.

q Confi rm

w Click

When the DHCP Enabled fi eld is set to “Yes” in 
the “Network Connection Details” window, the 
DHCP server assigns a dynamic IP address to 
your PC.
Because of this, Remote stations will have to 
match the IP address each time to access the 
Server.
If the DHCP Enabled fi eld is set to “Yes,” 
we recommend that you let Remote stations 
access the Server using its computer name. (p. 
38)

Windows 7

 ■ Confi rming Server Address or Network Name

 D When confi guring the remote control system through a LAN

 To let Remote stations access the Server using its IP address (continued)
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 DWhen configuring the remote control system through the Internet
If you configure the remote control system through the Internet, Remote stations can access the Server using its 
public IP address. If you utilize a Dynamic DNS service, Remote stations can access the Server by not only its 
public IP address, but also by its domain name.

To let Remote stations access the Server using its public IP address

A public IP address is an address that is accessible over the global Internet. If you use a dynamic public IP 
address, it is chosen from a pool of available addresses and changes each time you connect to the Internet. 
Because of this, Remote stations will have to match the IP address each time to access the Server.
If you use a dynamic public IP address, we recommend that you utilize the Dynamic DNS service to allow the 
Remote stations to access the Server using its domain name, or use a static public IP address.
Ask the router’s manufacturer about how to configure your router to set the public IP address.

IP address: 192.168.0.100

Computer name: Base PC

IP address

WAN: ✽✽✽.✽✽✽.✽✽✽.✽✽✽

LAN: 192.168.0.1

PC

Icom radio

PC

(Server)

Router Router

Request “✽✽✽.✽✽✽.✽✽✽.✽✽✽”

(Public IP address)

InternetInternet

Base station Remote station

■ Confirming Server Address or Network Name (Continued)
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To let Remote stations access the Server by its domain name

If you set up an account for a Dynamic DNS server, you can configure your router to update the Dynamic DNS 
server with your dynamic IP address. Even if you don’t have a static public IP address, you can allow Remote 
stations to access the Server through the Internet, using its domain name.
Ask the router’s manufacturer about how to configure your router to use the Dynamic DNS services.

Dynamic DNS

server

Update with your dynamic

IP address

IP address: 192.168.0.100

Computer name: Base PC

IP address

WAN: ✽✽✽.✽✽✽.✽✽✽.✽✽✽

LAN: 192.168.0.1

Domain name

Icom-rsba1.com

PC

Icom radio

PC

(Server)

Router Router

Request “Icom-rsba1.com”

(Domain name)

InternetInternet

Base station
Remote station

■ Confirming Server Address or Network Name

 D When configuring the remote control system through the Internet (continued)
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WHEN CONNECTING TO THE NETWORK DIRECTLY3

The settings in this section are necessary only when using one of the following radios.

• IC-7851

• IC-7850

• IC-7800 (Firmware version 3.00 or later)

• IC-7700 (Firmware version 2.00 or later)

• IC-7610

If you use other Icom radio, skip this section and go to section 4. (p. 33) (As of August 2017)

This section describes about the Base staion’s settings when connecting to the network directly.

 ■ Radio’s presetting ............................................................................................................................................................... 46
DThe following manual settings are required when operating the RS-BA1 ........................................................................ 46
DThe following settings are automatically set to the radio ................................................................................................. 46

 ■ Network setting ................................................................................................................................................................... 47
 ■ User registration.................................................................................................................................................................. 49
DTo register a user ............................................................................................................................................................. 49

 ■ Radio registration ................................................................................................................................................................ 51
DRadio’s basic information setting ..................................................................................................................................... 51
DAdjust limitation setting .................................................................................................................................................... 52

 ■ Confirming Server Address or Network Name .................................................................................................................... 54
DWhen configuring the remote control system through a LAN .......................................................................................... 54
DWhen configuring the remote control system through the Internet .................................................................................. 56
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■ Radio’s presetting

The RS-BA1 remotely controls the radios with the Network function using CI-V (Icom Communication Interface) 
commands.

See the CI-V command table in the radio’s instruction manual for details of the functions that can be controlled.

 DThe following manual settings are required when operating the RS-BA1
Properly preset the items in the table below for functions that cannot be controlled by CI-V commands, or 
for items that may cause unintended actions. See the radio’s instruction manual for details of the settings or 
operation.

NOTE: 

 • Remove any transverter that is connected to the radio.
 • To prevent accidental transmission, remove any keyer, keypad or other external input equipment connected to 
the radio.

 • We recommend you enable the Time-Out Timer function to prevent the radio from continuously transmitting.

Genre Item Setting

Function Timer/Sleep Timer function Set the timer to OFF or to your schedule

Volume Volume for the RX audio Set the volume to a suitable level

CI-V CI-V address Desired CI-V Address

Example: the radios’ default setting.

IC-7851/IC-7850: 8Eh, IC-7800: 6Ah, IC-7700: 74h, IC-7610: 98h

( When another device is connected to the system, make sure you 

do not to set a duplicate address.)

CI-V baud rate Set to 19200 bps (or Auto)

If you are using the IC-PW1 with the transceiver, be sure to set the CI-V baud rate to 19200 bps. After changing 
the transceiver’s CI-V settings, be sure to reset the CPU of the IC-PW1 and set the transceiver’s CI-V settings 
on the IC-PW1. See the IC-PW1 instruction manual for details.

 DThe following settings are automatically set to the radio
When the RS-BA1’s Remote Controller connects to the radio, and you select the model name on the Connect Set-

ting screen, the following items are automatically set. When you manually operate the radio, set these items as 

desired.

Genre Item Action

Function MAIN/SUB Tranking function

(For only the IC-7851, IC-7850, IC-7610)

Automatically set to OFF

RIT function Automatically set to OFF

∂TX function Automatically set to OFF

SSB/CW Synchronous Tuning Automatically set to OFF

Calibration Marker Automatically set to OFF

VOX function Automatically set to OFF

Scan function Automatically cancel the scan

Display Dualwatch function

(For only the IC-7851, IC-7850, IC-7800, IC-7610)

Automatically set to OFF

Memory channel Automatically set to the VFO mode

CI-V CI-V transceive Automatically set to ON
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Configure the network environment of your radio (IC-7610, IC-7700 with firmware version 2.00 or later, IC-7800 
with firmware version 3.00 or later, IC-7850, or IC-7851) in the Others set mode.
The settings will take effect after rebooting the radio.

■ Network setting

 • Except for the IC-7610

1. “Network Control” setting

1. Hold down [EXIT/SET] for 1 second to select the 
Set mode menu screen.

2. Push [OTHERS](F-5) to enter the Others set 
mode.

3. Push [▲](F-1) or [▼](F-2) to select “Network 
Control.”

4. Rotate the main dial to select “ON.” 

q Select

 

NOTE:

If you select “OFF,” the Remote station cannot 
access the radio.

2. “Default Gateway” setting

NOTE:

This setting is necessary when the remote control 
system is configured through the Internet.

5. Push [▲](F-1) or [▼](F-2) to select “Default 
Gateway.”

6. Push [◀▶](F-3) to select the desired address 
part, then rotate the main dial to set the IP 
address of the LAN side on the router. 
(Example: 192.168.0.1) 

w Set

3.  “Control Port (UDP)” 

“Serial Port (UDP)” 

“Audio Port (UDP)” confirmation
7. Push [▲](F-1) or [▼](F-2) to show “Control Port 

(UDP),” “Serial Port (UDP)” or “Audio Port (UDP).”
8. Confirm the port numbers of the Control, Serial 

and Audio ports. 

You should use the default port numbers for these 

ports. 

e Confirm

NOTE:

If you configure the remote control system through 
the Internet, and change the port number of the 
Control, Serial or Audio port, you should configure 
the port forwarding settings and the IP filter settings 
on your router once again. (p. 12)
If you change the port number, you can hold down 
[DEF](F-4) for 1 second to return them to their 
default value.

4. “Internet Access Line” setting

9. Push [▲](F-1) or [▼](F-2) to select “Internet 
Access Line.”

10. Rotate the main dial to select your internet 
access line type in the Internet Access Line 

item.
 • FTTH: Fiber To The Home
 • ADSL/CATV: ADSL or Cable television

r Select

5. Saving the settings

11. Reboot the radio. 

The settings will take effect after rebooting.
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■ Network setting (Continued)

 • For the IC-7610

1. “Network Control” setting

1. Push [MENU] to display the MENU screen.
2. Touch [SET] to enter the Set mode.
3. Touch [Network].
4. Touch “Network Control.”
5. Touch “ON.” 

 

NOTE:

If you select “OFF,” the Remote station cannot 
access the radio.

2. “Default Gateway” setting

NOTE:

This setting is necessary when the remote control 
system is configured through the Internet.

6. Touch “Default Gateway.”
7. Enter the IP address of the LAN side on the 

router. 

(Example: 192.168.0.1) 

Enter

3.  “Control Port (UDP)” 

“Serial Port (UDP)” 

“Audio Port (UDP)” confirmation
8. Touch [▲] or [▼] to display “Control Port (UDP),” 

“Serial Port (UDP)” or “Audio Port (UDP).”
9. Confirm the port numbers of the Control, Serial 

and Audio ports. 

You should use the default port numbers for 
these ports. 

e Confirm

NOTE:

If you configure the remote control system through 
the Internet, and change the port number of the 
Control, Serial or Audio port, you should configure 
the port forwarding settings and the IP filter settings 
on your router once again. (p. 12)
If you change the port number, push [QUICK] and 
touch “Default” to return them to their defaults.

4. “Internet Access Line” setting

10. Touch “Internet Access Line.”
11. Touch your internet access line type.

 • FTTH: Fiber To The Home
 • ADSL/CATV: ADSL or Cable television

r Select

5. Saving the settings

12. Reboot the radio. 

The settings will take effect after rebooting.
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In the set mode menu screen, register users (Remote 
station) to allow them to access the Server.
The Server verifies the user ID and password when 
Remote stations attempt to access the Server. If the 
User ID or password is incorrect, the Remote station 
cannot access the Server.

■ User registration

 DTo register a user
 • Except for the IC-7610

1. “User ID” setting

1. Hold down [EXIT/SET] for 1 second to select the 
set mode menu screen.

2. Push [OTHERS](F-5) to enter the Others set 
mode.

3. Push [▲](F-1) or [▼](F-2) to select “Network User 
1 ID.” 

4. Push [EDIT](F-5) to enter the User ID Edit mode.
5. Rotate the main dial to input a user ID of up to 16 

characters.
 • Push [ABC] or [abc] to toggle between upper and 
lower case letters.

 • Push [123] or [Symbol] to toggle between numerals 
and symbols.

 • You cannot register an already registered ID.
 • Push [◀](F-1) or [▶](F-2) for cursor movement.
 • Push [DEL](F-3) to delete the selected character.
 • You can input an ID using a keyboard, connected to 
the radio.

q Input

6. Push [SET](F-5) to set the User ID.

2. “Password” setting

7. Push [▲](F-1) or [▼](F-2) to select “Password.”
8. Push [EDIT](F-5) to enter the Password Edit 

mode.

9. Rotate the main dial to input a Password of 8 to 
16 characters, case-sensitive. 
At least two different characters must be used. 

w Input

10. Push [SET](F-5) to set the Password.

3. Setting the user as an administrator

11. Push [▲](F-1) or [▼](F-2) to select 
“Administrator.”

12. Rotate the main dial to select “YES” to set the 
user as an administrator. 

Administrator Remote stations can terminate a 

connection between another Remote station and 
a radio. 

e Select

 L If necessary, repeat steps 3 through 12 to register 
other users.

13. Push [EXIT/SET] twice to exit the Set mode.

NOTE:

To remove a Remote station from the User List, 
select “Network User1 ID,” “Network User2 ID” or 
“Network User3 ID,” and then push [DEL](F-3) on 
the edit mode to delete the User ID.
The deleted Remote station will not be able to 
access the Server.

To prevent unauthorized access:

Set a long and strong password so that no one can 
possibly guess it.
Mix upper and lower case letters, numbers or 
characters.
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■ User registration

 D To register a user (Continued)

 • For the IC-7610

1. “User ID” setting

1. Push [MENU] to display the MENU screen.
2. Touch [SET] to enter the Set mode.
3. Touch [Network].
4. Touch “Network User 1.” 

5. Touch “Network User 1 ID.”
6. Enter a user ID of up to 16 characters.

 • You cannot register an already registered ID.
 • Touch [←] or [→] for cursor movement.
 • Touch [CLR] to delete the selected character.
 • You can input an ID using a keyboard, connected to 
the radio.

q Enter

7. Touch [ENT] to set the User ID.

2. “Password” setting

8. Touch “Network User1 Password.”
9. Enter a Password of 8 to 16 characters, case-

sensitive. 
At least two different characters must be used. 

w Enter

10. Touch [ENT] to set the Password.

3. Setting the user as an administrator

11. Touch “Network User1 Administrator.”
12. Touch “YES” to set the user as an administrator. 

Administrator Remote stations can terminate a 

connection between another Remote station and 
a radio. 

e Select

 L If necessary, repeat steps 3 through 12 to register 
the other user.

13. Push [MENU] to exit the Set mode.

NOTE:

To remove a Remote station from the User List, 
touch “Network User1 ID” or “Network User2 ID,” 
and then touch [CLR] to delete the User ID.
The deleted Remote station will not be able to 
access the Server.
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In the set mode menu screen, register the radios to be used with the Server.

■ Radio registration

 DRadio’s basic information setting
 • Except for the IC-7610

1. Hold down [EXIT/SET] for 1 second to select the 
set mode menu screen.

2. Push [OTHERS](F-5) to enter the Others set 
mode.

3. Push [▲](F-1) or [▼](F-2) to select “Network 
Radio Name.”

4. Push [EDIT](F-5) to enter the Network Radio 
Name Edit mode. 

5. Rotate the main dial to input a Network Radio 
Name of up to 16 characters.
 • Push [ABC] or [abc] to toggle upper and lower case 
letters.

 • Push [123] or [Symbol] to toggle between numerals 
and symbols.

 • Push [◀](F-1) or [▶](F-2) for cursor movement.
 • Push [DEL](F-3) to delete the selected character.
 • You can input an ID using a keyboard connected to 
the radio.

6. Push [SET](F-5) to set.
7. Push [▲](F-1) or [▼](F-2) to select “CI-V 

Address.” 

q Set

8. Rotate the main dial to input a CI-V address.
9. Push [▲](F-1) or [▼](F-2) to select “CI-V Baud 

Rate.” 

q Select

10. Rotate the main dial to select the baud rate.

11. Push [EXIT/SET] twice to exit the Set mode.

 • For the IC-7610

1. Push [MENU] to display the MENU screen.
2. Touch [SET] to enter the Set mode.
3. Touch [Network].
4. Touch “Network Radio Name.”
5. Enter a Network Radio Name of up to 16 characters.

 • Touch [←] or [→] for cursor movement.
 • Touch [CLR] to delete the selected character.
 • You can input an ID using a keyboard connected to 
the radio.

q Enter

6. Touch [ENT], and then push [EXIT].
7. Touch [Connectors].
8. Touch “CI-V.”
9. Touch “CI-V Address.”
10. Set a CI-V address, and then push [EXIT]. 

w Set

11. Touch “CI-V Baud Rate.”
12. Touch the baud rate. 

e Select

13. Push [MENU] to exit the Set mode.
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■ Radio registration (Continued)

1. Hold down [EXIT/SET] for 1 second to select the 
Set mode menu screen.

2. Push [OTHERS](F-5) to enter the Others set 
mode.

3. Push [▲](F-1) or [▼](F-2) to select “Network AF 
Sample Rate.” 

4. Rotate the main dial to limit the received audio 
sampling rate that Remote stations can adjust. 

Higher sampling rates will improve the audio 
quality. However, they also increase the 
amount of data, which can cause voice delay or 
jumpiness, depending on the network condition. 
Lower sampling rates will decrease the audio 
quality. However, they also decrease the amount 
of data.
 • For the IC-7851, IC-7850, and IC-7610, the rates are 
fixed to: 
8kHz, 12kHz, 16kHz, 24kHz, 48kHz.

5. Push [▲](F-1) or [▼](F-2) to select “Network AF 
Codecs.”

6. Rotate the main dial to limit the received audio 
codec that Remote stations can adjust.
 • For the IC-7851, IC-7850, and IC-7610, the codecs 
are fixed to: 
LPCM 8bit, u-law 8bit, LPCM 16bit.

7. Push [▲](F-1) or [▼](F-2) to select “Network AF 
Channels.”

8. Rotate the main dial to select whether or not to 
allow Remote stations to select stereo sound. 
When you select “1ch” (monaural), Remote 
stations cannot program “2ch” (stereo). 
If the Remote station selects “2ch,” stereo output 
(L=Main band; R=Sub band).
 • For the IC-7851, IC-7850, and IC-7610, the channel 
is fixed to “2ch.”

9. Push [▲](F-1) or [▼](F-2) to select “Network 
MOD Use.” 

10. Confirm that “ON” is selected in “Network MOD 
Use.”
 • For the IC-7851, IC-7850, and IC-7610, the function 
is fixed to “ON.”

11. Push [▲](F-1) or [▼](F-2) to select “Network 
MOD Sample Rate.”

12. Rotate the main dial to limit the modulation audio 

sampling rate that Remote stations can adjust. 

Higher sampling rates will improve the audio 
quality. However, they also increase the 
amount of data, which can cause voice delay or 
jumpiness, depending on the network condition. 
Lower sampling rates will decrease the audio 
quality. However, they also decrease the amount 
of data.
 • For the IC-7851, IC-7850, and IC-7610, the rates are 
fixed to: 
8kHz, 12kHz, 16kHz, 24kHz, 48kHz

13. Push [▲](F-1) or [▼](F-2) to select “Network 
MOD Codecs.”

14. Rotate the main dial to limit the modulation audio 

codec that Remote stations can adjust.
 • For the IC-7851, IC-7850, and IC-7610, the codecs 
are fixed to: 
LPCM 8bit, u-law 8bit, LPCM 16bit.

15. Push [EXIT/SET] twice to exit the Set mode.

 DAdjust limitation setting
Remote stations can adjust the sound quality or audio codec. Higher audio qualities will increase the amount of 
data, which can cause voice delay or jumpiness, depending on the network condition.
The Server can limit the maximum level of the sound quality or audio codec.
Remote stations cannot program higher values than the values programmed here.
 • The following settings are not included with the IC-7851, IC-7850, and IC-7610. However, the settings are 
originally fixed in those transceivers.
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 • Except for the IC-7610

1. Hold down [EXIT/SET] for 1 second to select the 
set mode menu screen.

2. Push [OTHERS](F-5) to enter the Others set 
mode.

3. Push [▲](F-1) or [▼](F-2) to select “Shutdown 
Function.” 

4. Rotate the main dial to select “Standby/
Shutdown.”

5. Push [EXIT/SET] twice to exit the Set mode.
6. Hold down [POWER] for 1 second.
7. Make sure that “Standby (for Remote Control)” is 

selected, and then push [POWER]. 

 • The transceiver is set to the standby mode and the 
LED above [POWER] blinks orange.

Information:

While “Standby (for Remote Control)” is selected in 
step 7, and [POWER] is pushed on the Others set 
mode after setting the radio network, the transceiver 
will be turned OFF instead of being in the standby 
mode.

Follow the steps below to set the standby mode.
1. Push [POWER] to turn ON the transceiver.
2. Push [POWER] again.
3. When the screen in step 7 is displayed, make 

sure “Standby (for Remote Control)” is selected, 
and then push [POWER].
 • The transceiver is set in the standby mode, and the 
LED above [POWER] blinks orange. 

 • For the IC-7610

1. Push [MENU] to display the MENU screen.
2. Touch [SET] to enter the Set mode.
3. Touch [Network].
4. Touch “Power OFF Setting (for Remote Control).”
5. Touch “Standby/Shutdown.” 

6. Push [MENU] to exit the Set mode.
7. Hold down [POWER] for 1 second.
8. Touch “Standby (for Remote Control).” 

 • The transceiver is set to the standby mode and the 
LED above [POWER] blinks orange.

Information:

After setting the radio network, the transceiver will be 
turned OFF instead of being in the standby mode.

Follow the steps below to set the standby mode.
1. Push [POWER] to turn ON the transceiver.
2. Push [POWER] again.
3. When the screen in step 7 is displayed, touch 

“Standby (for Remote Control).”
 • The transceiver is set in the standby mode, and the 
LED above [POWER] blinks orange. 

■ Radio registration

 D Adjust limitation setting (continued)

Standby mode setting

To remotely control the transceiver using the RS-BA1, the transceiver’s power must be either turned ON or set in 
the standby mode.
Follow the steps described below to set the transceiver in the standby mode.
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 DWhen configuring the remote control system through a LAN
If you configure the remote control system through a LAN, Remote stations can access the Server using its IP 
address. 

The example below describes how to find out the Base station’s IP address, to be requested by Remote stations.

IP address: 192.168.0.10

Network Name: IC-7851

PC

Request “192.168.0.10” (IP address)

or “IC-7851” (Network Name).

Router

Base station

Remote station

IC-7851

IC-7850

IC-7800 (firmware version 3.00 or later)

IC-7700 (firmware version 2.00 or later)

IC-7610

(Radio/Server)

To let Remote stations access the Server using its IP address

An IP address is a numerical label that is assigned to devices participating in a computer network.

Check your radio’s IP address to let Remote stations access the Server.

• Except for the IC-7610

1. Hold down [EXIT/SET] for 1 second to select the 
Set mode menu screen.

2. Push [OTHERS](F-5) to enter the Others set 
mode.

3. Push [▲](F-1) or [▼](F-2) to select “IP Address.”
4. Check the IP address that is displayed in the IP 

Address field. (Example: 192.168.0.10)

Check

5. Push [EXIT/SET] twice to exit the Set mode.

For the IC-7851, IC-7850, and IC-7610 users:

The DHCP function is set to ON as default. We recommend that you assign the server using the network name. If 
you want to assign the server using an IP address, set the “DHCP” item OFF in the Others set mode.

• For the IC-7610

1. Push [MENU] to display the MENU screen.
2. Touch [SET] to enter the Set mode.
3. Touch [Network].
4. Touch [▲] or [▼] to display “IP Address.”
5. Check the IP address that is displayed in the IP 

Address field. (Example: 192.168.0.10)
 

Check

6. Push [MENU] to exit the Set mode.

When you configure the remote system, Remote stations can access the Server using its IP address, computer 
name, network name, or domain name.

■ Confirming Server Address or Network Name



3 WHEN CONNECTING TO THE NETWORK DIRECTLY

55

To let Remote stations access the Server using its network name

A network name is an identification information assigned to each device participating in a computer network.

Check your radio’s network name to let Remote stations access the Server.

•  This function is only for the IC-7851, IC-7850, and IC-7610 transceivers.

• Except for the IC-7610

1. Hold down [EXIT/SET] for 1 second to select the 
Set mode menu screen.

2. Push [OTHERS](F-5) to enter the Others set 
mode.

3. Push [▲](F-1) or [▼](F-2) to select “Network 
Name.”

4. Check the network name that is displayed in the 
Network Name field. (Example: IC-7851)

Check

5. Push [EXIT/SET] twice to exit the Set mode.

• For the IC-7610

1. Push [MENU] to display the MENU screen.
2. Touch [SET] to enter the Set mode.
3. Touch [Network].
4. Touch [▲] or [▼] to display “Network Name.”
5. Check the network name that is displayed in the 

Network Name field. (Example: IC-7610)
 

Check

6. Push [MENU] to exit the Set mode.

■ Confirming Server Address or Network Name

 D When configuring the remote control system through a LAN (continued)
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 DWhen configuring the remote control system through the Internet
If you configure the remote control system through the Internet, Remote stations can access the Server using its 
public IP address. If you utilize a Dynamic DNS service, Remote stations can access the Server by not only its 
public IP address, but also by its domain name.

To let Remote stations access the Server using its public IP address

A public IP address is an address that is accessible over the global Internet. If you use a dynamic public IP 
address, it is chosen from a pool of available addresses and changes each time you connect to the Internet. 
Because of this, Remote stations will have to match the IP address each time to access the Server.
If you use a dynamic public IP address, we recommend that you utilize the Dynamic DNS service to allow the 
Remote stations to access the Server using its domain name, or use a static public IP address.
Ask the router’s manufacturer about how to configure your router to set the public IP address.

IP address: 192.168.0.10

IP address

WAN: ✽✽✽.✽✽✽.✽✽✽.✽✽✽

LAN: 192.168.0.1

PC

Router
Router

Request “✽✽✽.✽✽✽.✽✽✽.✽✽✽”

(Public IP address)

(Radio/Server)

InternetInternet

Base station Remote station
IC-7851

IC-7850

IC-7800 (firmware version 3.00 or later)

IC-7700 (firmware version 2.00 or later)

IC-7610

■ Confirming Server Address or Network Name (Continued)
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To let Remote stations access the Server by its domain name

If you set up an account for a Dynamic DNS server, you can configure your router to update the Dynamic DNS 
server with your dynamic IP address. Even if you don’t have a static public IP address, you can allow Remote 
stations to access the Server through the Internet, using its domain name.
Ask the router’s manufacturer about how to configure your router to use the Dynamic DNS services.

Dynamic DNS

server

Update with your dynamically

 changing IP address

IP address: 192.168.0.10

IP address

WAN: ✽✽✽.✽✽✽.✽✽✽.✽✽✽

LAN: 192.168.0.1

Domain name

Icom-rsba1.com

PC

Router Router

Request “Icom-rsba1.com”

(Domain name)

InternetInternet

Base station Remote station
IC-7851

IC-7850

IC-7800 (firmware version 3.00 or later)

IC-7700 (firmware version 2.00 or later)

IC-7610

(Radio/Server)

■ Confirming Server Address or Network Name

 D When configuring the remote control system through the Internet (continued)
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SETTINGS FOR A REMOTE STATION PC4

Configure your PC’s environment in the Base station’s Remote Utility.
The settings will take effect after rebooting the Remote Utility.
When you first open the Remote Utility, the Settings screen appears.
After configuring the settings, you can display other setting screens.

■ Setting your PC’s environment

1. Click “Options.”
2. Click “Settings.”

 • The “Settings” screen is displayed.
3. Configure the settings.
4. Click <OK> to save the settings.

 • The “Take effect after restarting the application” 
screen is displayed.

5. Click <OK>. 
The settings will take effect after rebooting the 

Remote Utility.

1Click

2Click

3Set

4Click

5Click

1

2

3

4

1	PC Name

 Enter a name for your PC of up to 16 characters.
 DO NOT use the same name for more than one PC on your network.

2	Port numbers

 Enter the port numbers of the Control, Serial, and Audio port.
 You should use the default port numbers for these ports.

3	Internet Access Line

 Select your internet access line type.

4	Language

 Select the software display language.
 The selected language will be used as the Help file language.

NOTE:

If you configure the remote control system through the Internet, and change the port number of the Control, 
Serial or Audio port, you should configure the port forwarding settings and the IP filter settings on your router 
once again. (p. 12)
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To connect to a radio through the network, Remote stations should first connect to a Server using the Remote 
Utility. Before connecting, register the Server information.

 DTo add a Server
Procedure

■ Server Registration

Step 1:

Open the Add a Server screen.
Server List screen  <Add>

Step 2:

Enter the Server Information.

Step 3:

Enter the User ID and Password.

Step 4:

Adding the Server has completed.

NOTE:

When you add a server from the Setup Wizard screen:
 • When connecting to the network throught a PC, click Setup for a Remote PC (Connect through a Server 

PC). (Installtion guide A Step5.)
 • When connecting to the network directly, click Setup for a Remote PC (A radio with the Server function). 

(Installtion guide B Step4.)
 LTo display the Setup Wizard screen, click Setup Wizard on the top menu.
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■ Server registration

 D To add a Server (Continued)

1 Open the Add a Server screen.

1. Click the <Server List> tab.
2. Click <Add>.

2 Enter the Server Information.

1. Enter the Server Address or Network Name.
2. Confirm the Control port number.

 L You should use the default port number for this 
port.

3. Click <Next>>. 1Enter

3Click

1Click

2Click

About Server Address or Network name

When connecting to the network through a PC

 • When configuring the remote control system 
through a LAN, enter IP address or computer 
name of the Base station’s PC. (pp. 38 to 44)

 • When configuring the remote control system 
through the Internet, enter domain name or public 
IP address of the Base station’s PC. (pp. 43 to 
44)

When connecting to the network directly

 • When configuring the remote control system 
through a LAN, enter IP address of the radio or 
network name*. (pp. 54 to 55)

 • When configuring the remote control system 
through the Internet, enter domain name or public 
IP address of the Base station. (pp. 56 to 57)

* For only the IC-7851, IC-7850, and IC-7610.

2Cofirm
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■ Server registration

 D To add a Server (Continued)

3
Enter the User ID and Password.

1. Enter the user ID and password that are 
registered in the server.
 • When connecting to the network through a 
PC, enter the user ID and password that are 
registered in the Base station’s Remote Utility.

 • When connecting to the network directly, enter 
the user ID and password that are registered in 
the radio.

2. Click <Next>>.
 • After clicking <Next>>, connects to the Server.

1Enter

2Click

4
Adding the Server has completed.

1. Enter the Server Description.
 L The Server Address or Network Name is 
entered by default.

2. Click <Finish>.
1Enter

2Click

NOTE:

If you cannot connect to the Server, the error 
screen is displayed.
Click <<Back>, and confirm the settings.
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■ Server registration (Continued)

 DTo change a server properties
1. Click the <Server List> tab.
2. Select a server.
3. Click <Properties>.
4. Change the settings, and then click <OK>.

1Click

2Select

3Click

 DTo delete a server
1. Click the <Server List> tab.
2. Select a server.
3. Click <Remove>. 1Click

2Select

3Click
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■ Connecting to the Server
 DConnecting to the Server

1. Click the <Server List> tab.
2. Select a server.
3. Click <Connect>.

 • “Connected” is displayed under the Server name 
when the connection has succeeded.
 L If the connection fails, and an error screen 
is displayed, solve the problem using the “6. 
TROUBLESHOOTING” section. (p. 77)

 DDisconnecting from the Server
1. If you remotely control the radio, disconnect the 

radio in the Remote station’s Remote Controller.
2. In the Remote station’s Remote Utility, click the 

<Server List> tab.
3. Select the connecting server.
4. Click <Disconnect>.

1Click

2Select

3Click

1Click

2Select

3Click



4 SETTINGS FOR A REMOTE STATION PC

64

■ Connection setting

When the connection to the Server has succeeded, the radios that are physically connected to the Server are 
displayed on the Radio List screen of the Remote station’s Remote Utility.
Select a radio from the list, then connect it to the network using the Remote Utility.
You have to configure the network audio quality and devices to connect.

 LTo control the radio, connect to the radio using the Control software.

NOTE: 

If the connection setting is finished, you can simply connect to the radio by selecting it in the Radio List screen 
and then clicking <Connect>.

1. Click the <Radio List> tab.
2. Select a radio.

3. Click <Settings>.
 L Radios that are “<<Connected>>” or “Offline,” the 
Connection Setting cannot be changed.

1Click

2Select

3Click
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■ Connection Setting (Continued)

 DNetwork audio quality setting

Radio List > <Settings>

1. Click <Recommended>.
 • The Select Network screen appears.

2. Select the connection to a radio either through a 

LAN, or the Internet.
3. Click <Next>.

 • The recommended values for your network are 
displayed. 

4. Click <Yes> to automatically set the displayed 
values in each field of the Network Setting, then 
close the Select Network screen.

NOTE: To use the IF signal for receiving, set 
“Sample Rates” to 48 kHz.

1Click

3Click

4Click

2Select

 DDevice setting

Radio List > <Settings>

1. Select a COM port number in the Virtual COM 

Port Number menu.
 • The selected COM port number is used for CI-V 
operation with the radio.
 L When you connect to the radio with a control 
software, you have to set the COM port number.

2. Select an audio device in the Speaker menu to 

which your speaker is connected, to output the 
received audio from the network.

3. Select an audio device in the Mic menu to which 
your microphone is connected, to transmit the 
input audio to the network.

1Select

2Select

3Select
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■ Connecting to a radio

If the connection setting is finished, you can simply connect to the radio by selecting it in the Radio List screen 
and then clicking <Connect>.

 DConnecting to a radio
1. Click the <Radio List> tab.
2. Select a radio.

3. Click <Connect>.
4. Click <OK>.

 • “<<Connected>>” is displayed under the radio name 
when the connection has succeeded.
 L If the connection fails, and an error screen 
is displayed, solve the problem using the “6. 
TROUBLESHOOTING” section. (p. 77)

1Click

2Select

3Click

4Click

 DDisconnecting from a radio
1. In the Remote station’s Remote Utility, open the 

Radio List screen.
2. Select a radio with “<<Connected>>” under its 

name.

3. Click <Disconnect>.
 • “Do you want to disconnect the radio?” is displayed.

4. Click <Yes> to disconnect the radio. 

NOTE: 

 • Be sure to disconnect when not using the radio. 
Otherwise, other Remote stations cannot connect 
to it.

 • The Server or administrator Remote stations 
can terminate a connection between another 
Remote station and a radio. If “<<Connected>>” 
disappears while connecting to a radio, the Server 
or authorized Remote station may terminate the 
connection.

1Click

2Select

3Click

4Click
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■ Audio adjustment using the Remote Utility

While connected to a radio, you can adjust the received and transmit audio volume through the network using the 
Remote station’s Remote Utility.
The description in this section is based on the assumption that the connection to the radio has succeeded 

(“<<Connected>>” is displayed under the radio name).

 DReceived audio volume adjustment
1. In the Remote station’s Remote Utility, open the 

Radio List screen.
2. Select a radio with “<<Connected>>” under its 

name.

3. Click <AF>.
4. Slide the adjustment bar on the Volume field 

up or down to adjust the received audio volume 
level.

 L Click <Mute> to mute the audio, and click once 
again to hear the audio.

5. Click <Close> to close the screen.

NOTE: 

 • The AF adjustment bar on the Volume field moves 
together with the [AF] control of the Remote 
Controller. However, if you use another control 
software, the audio volume level on the network 
can only be adjusted with the Remote Utility.

 • You cannot adjust the received audio volume level 
of the radio’s speaker, with the Remote Utility. 
Use the [AF] control on the radio to adjust it.

1Click

2Select

3Click

4Adjust

5Click



4 SETTINGS FOR A REMOTE STATION PC

68

■ Audio adjustment using the Remote Utility (Continued)

 DTransmit audio volume adjustment
1. In the Remote station’s Remote Utility, open the 

Radio List screen.
2. Select a radio with “<<Connected>>” under its 

name.

3. Click <MOD>.
4. Select “Mic” on the MOD Select field.
5. Slide the adjustment bar on the Volume field up 

or down to adjust the transmit audio volume level.
6. Click <Close> to close the screen.

NOTE: 

You cannot adjust the modulation input level of the 
radio with the Remote Utility. Adjust the modulation 
input level of the radio in the radio’s Set mode, or 
using the Remote Controller. (p. 74)

1Click

2Select

3Click

5Adjust

6Click

4Select
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■ Recording and playback functions

While connected to a radio, you can record the received audio and save it into the PC’s hard disk using the 
Remote station’s Remote Utility.
Also, you can transmit an audio file to the radio using the Remote Utility.
The description in this section is based on the assumption that the connection to the radio has succeeded 

(“<<Connected>>” is displayed under the radio name).

 DRecording received audio
1. In the Remote station’s Remote Utility, open the 

Radio List screen.
2. Select a radio with “<<Connected>>” under its 

name.

3. Click <AF>.
4. Click < > to start recording.

 L While recording, click < > to pause.
5. Click < > to stop recording.

NOTE: 

 • When you click <Open Folder>, the folder in 
which the recording file is stored will be displayed.

 • If you want to change the recording folder, click 
the < > button, then select a folder in the 
Browse For Folder screen.

 • Adjust the sample rate frequency and codec 
to record the audio according to the recording 

purpose. When you record the audio received 
from the network, we recommend that you set the 
same sample rate frequency and codec that are 
programmed in the Connection Setting screen.

1Click

2Select

3Click

Record button

Stop button

Pause button

Open the folder
Recording file name
Elapsed time

Folder browse buttonRecording folder name
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■ Recording and playback functions (Continued)

 DPlaying back/transmitting an audio file
1. In the Remote station’s Remote Utility, open the 

Radio List screen.
2. Select a radio with “<<Connected>>” under its 

name.

3. Click <MOD>.
4. Select “File” on the MOD Select field.
5. Click <Open> to select an audio file* to play or 

transmit. 

*  Only uncompressed, linear, PCM WAV files are 
supported.

6. Click < > to start playing/transmitting.
 L While playing/transmitting, click < > to pause.

7. Click < > to stop playing/transmitting.

1Click

2Select

3Click

NOTE: 

You can also use the Remote Controller’s Voice 
Memory function to play back or transmit an audio 
file.
See the Remote Controller’s help file for details. 
To display the help file, click “Contents” in the Help 
menu on the Remote Controller, or push the [F1] 
key on your PC’s keyboard.

Playback button

Stop button

Pause button

Open the folder
Audio file name
Elapsed time
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REMOTE CONTROLLER’S BASIC OPERATION5

This section describes how to connect to a radio and remotely control it using the Remote Controller.
There are two ways to connect to the radio with the Remote Controller:
1. Connecting to the radio through a network using the Remote Utility (p. 72)
2. Directly connecting to the radio that is physically connected to your PC, instead of using the Remote Utility (p. 73)

 LWhen using the Network function of the radio (IC-7610, IC-7700 with firmware version 2.00 or later, IC-7800 
with firmware version 3.00 or later, IC-7850, or IC-7851), connect to the radio through the network.

■ Connecting to a radio with the Remote Controller

Connects to the radio (pp. 72, 73)

About the Remote mode (p. 74)

Displays the Connect Setting screen (pp. 72, 73)

To use transmit audio input from the PC (p. 74)

NOTE:

See the RS-BA1 Remote Controller’s help file for remote operation details, such as how to change the 
frequency, or turn ON each function.
To display the help file, click “Contents” in the Help menu on the Remote Controller, or push the [F1] key on your 
PC’s keyboard.
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 DConnecting to a radio through a network
To connect to a radio through a network using the Remote Controller, first you have to access the radio using the 
Remote Utility.
To connect the radio using the Remote Utility, see page 36 when you are operating as the Server, or see page 
66 when you are operating as a Remote station.

1. Double-click the “RS-BA1 Remote Control” icon 
on your desktop to open the Remote Controller.

2. Click the icon in the toolbar as shown to 
the right, or click “Connect Setting...” in 
the [Option] menu, to display the Connect 
Setting screen.
 • The Connect Setting cannot be set while the radio is 
connected.

3. Select a radio that you want to control in the 
Model menu.
 • The items that cannot be used in the selected model 

will be grayed out.
4. Select how to connect to the transceiver between 

REMOTE, REMOTE/RS-232C, RS-232C, LAN, 
and USB.
 • The selectable device differs, depending on the 
transceiver.

 • When the “MOD Select has also been changed.” 
dialog is displayed, click <OK>.

 • The confirmation dialog for the connection setting 
may be displayed, depending on the transceiver. If 
connected correctly, click <OK>.

5. Select a radio that you are accessing with the 
Remote Utility, in the Remote Utility menu.
 • The CI-V settings are automatically loaded from 
the Remote Utility to the CI-V field. The settings 
include the virtual COM Port number, the radio’s CI-V 
address and baud rate and the virtual audio device 
for the Voice Memory function.
 L If the desired radio is not displayed in the Remote 

Utility menu, click <Search> to load the radios’ 
information from the Remote Utility.

6. Click the Software closing turns OFF the 

Radio. box to make a check mark to turn OFF 
the radio when the Remote Controller is closed 
by clicking < > or [Exit] on the File menu.
 • Only for transceivers that can be turned ON or OFF 
with the CI-V Power ON/OFF command.

 • When the PC is shut down while the Remote 
Controller is still running, the transceiver’s power may 
not be turned OFF.

7. Click <OK> to save the settings, and close the 
Connect Setting screen.

■ Connecting to a radio with the Remote Controller (Continued)

8. Click the icon in the toolbar as shown to 
the right, or click “Connect ON” in the [File] 
menu, to connect to the radio.
 • When the connection has succeeded, the radio’s 
current data will be displayed on the main panel.

 • If the connection fails, and an error screen 
is displayed, solve the problem using the “6. 
TROUBLESHOOTING” section. (p. 77)

 • To disconnect from the radio, click the icon 
as shown to the right, or click “Connect OFF” 
in the [File] menu. 
-  The radio will be turned OFF if it can be turned ON 

or OFF with the CI-V Power ON/OFF command.

q Select

e Select

t Click

r Click

w Select

If you insert a check mark, the radio power 
turns OFF when closing the software.
See the Help file for the Remote Control 
software for more details.
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 DDirectly connecting to a radio
If a radio is physically connected to your PC, you can directly access the radio using the Remote Controller, 
instead of using the Remote Utility.
 • When you are operating a radio on the remote control system with the Remote Controller, without having used 
the Remote Utility to connect, let other users know that the radio is being used.

1. Double-click the “RS-BA1 Remote Control” icon 
on your desktop to open the Remote Controller.

2. Click the icon in the toolbar as shown to 
the right, or click “Connect Setting...” in 
[Option] menu, to display the Connect 
Setting screen.

3. Select a radio that you want to control in the 
Model menu.
 • The items that cannot be used in the selected model 

will be grayed out.
4. Select how to directly connect to the radio in the 

Connection menu.
 • When the “MOD Select has also been changed.” 
dialog is displayed, click <OK>.

 • The confirmation dialog for the connection setting 
may be displayed, depending on the transceiver. If 
connected correctly, click <OK>.

5. Select “Not Use” in the Remote Utility menu.

6. Select the COM port number to which the radio is 
connected, in the COM Port menu.

7. Enter the radio’s CI-V address in the CI-V 

address (Radio) field, and select the radio’s 
baud rate in the Baud rate (bps) menu. 

If the radio’s baud rate is set to “Auto,” select 
“19200” in the Baud Rate (bps) menu. 

If you are using the Spectrum Scope function 
with the IC-7851, IC-7850, IC-7610, or IC-7300 
using a USB for the connection, select “115200” 
in the Baud Rate menu.
 • See page 21 for details of radio’s presetting.
 • To check or change the radio’s CI-V address and 
baud rate settings, see the instruction manual that 
comes with the radio.

8. Click the Software closing turns OFF the 

Radio. box to make a check mark to turn OFF 
the radio when the Remote Controller is closed 
by clicking < > or [Exit] on the File menu.
 • Only for transceivers that can be turned ON or OFF 
with the CI-V Power ON/OFF command.

 • When the PC is shut down while the Remote 
Controller is still running, the transceiver’s power may 
not be turned OFF.

9. Click <OK> to save the settings, and close 
the Connect Setting screen.

10. Click the icon in the toolbar as shown to 
the right, or click “Connect ON” in the [File] menu, 
and connect to the radio.
 • When the connection has succeeded, the radio’s 
current data will be displayed on the main panel.

 • If the connection fails, and an error screen 
is displayed, solve the problem using the “6. 
TROUBLESHOOTING” section.(p. 77)

 • To disconnect from the radio, click the icon 
as shown to the right, or click “Connect OFF” 
in the [File] menu. 
-  The radio will be turned OFF if it can be turned ON 

or OFF with the CI-V Power ON/OFF command.

q Select

w Select

e Select

y Click

t Click

r Enter

If you insert a check mark, the radio power 
turns OFF when closing the software.
See the Help file for the Remote Control 
software for more details.

■ Connecting to a radio with the Remote Controller (Continued)
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 D  To use transmit audio input from the PC
In order to use the transmit audio input from the PC 
when remotely controlling the radio using the Remote 
Controller, confi gure the following settings, according 
to the connection between the radio and the Base 
PC.
If you operate in the Remote station side, confi rm the 
radio’s connector that is connected to the Base PC.

1. Connect to a radio with the Remote Controller.
(pp. 72, 73)

2. Click [MIC SET] to open the MIC SET screen.
3. Select an appropriate connector in the MOD 

Select (Remote ON) menu, to input transmit 
audio from the PC to the radio.
The options differ, depending on the radio 
selected in the Model menu in the Connect 
Setting screen.
 • Right click <MOD LEVEL> to rotate clockwise, or left 
click it to rotate counterclockwise, to adjust the input 
level from the connector.

4. Click <  > to close the screen.

 D  About the Remote mode
When connected to the radio, the Remote Controller 
automatically turns ON the Remote mode.
While the Remote mode is ON, the Remote Controller 
transmits CI-V commands not only to check the 
radio’s current state, but also to remotely control it.
When you want the Remote Controller to only 
check the radio’s current state, or when you want to 
inhibit the Remote Controller from transmitting CI-V 
commands, while you manually operate the radio, 
turn OFF the Remote mode.

To turn OFF the Remote mode

Click the right icon on the toolbar, or click 
“Remote OFF” in the [File] menu.

To turn ON the Remote mode

Click the right icon on the toolbar, or click 
“Remote ON” in the [File] menu.

Information

You can select the desired connector(s) for transmit 
audio input when the Remote mode is OFF.
 • See the Remote Controller’s help fi le for “Remote 
Setting” details.

e Click

q Select

w Adjust

■ Connecting to a radio with the Remote Controller (Continued)

NOTE: DO NOT allow the PC to go into the sleep or 
standby mode while using the RS-BA1. Otherwise, 
it might not work properly after the PC resumes 
normal activity.
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■ To exit the Remote Controller

1. Disconnect the radio by clicking < > in the 
Remote Controller.

2. Close the Remote Controller.
3. Disconnect the radio connected to the Remote 

Utility on the Remote Station.
4. Close the Remote Station on the Remote Utility.

Follow the steps below to close and exit the remote control operation.

5. If you are connecting the radio through the PC, 
close the Remote Utility on the Base Station.

6. Turn OFF the Radio and the PC.
 • If you are using a radio that can be turned ON or OFF 
with the CI-V Power ON/OFF command, the radio is 
turned OFF when the radio is disconnected using the 
Remote Controller.

■ Operating guide

The following windows are displayed by ‘right-clicking’ on each button on the Remote Controller.
 • The windows that are displayed by ‘left-clicking,’ the buttons are marked in white (Example: MIC SET).
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 ■ Operating guide (Continued)

32

1  These screens are examples using the IC-7850 or IC-7851. The displayed screen differs, 

depending on the transceiver.

2 This setting window is displayed when the Tone function is used.

 • The setting window differs, depending on the used Tone function.
3 This setting window is displayed when the Duplex operation is used.

NOTE:

 • There are items you cannot set, depending on the connected radio.
 • RS-BA1 is for the single band operation.
 • Knobs can be changed to sliders on the Set Mode screen for the volume, squelch settings and so on.

1 1
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TROUBLESHOOTING6

The following descriptions are possible causes and solutions for the problem you are experiencing.
If you cannot solve the problem after trying these solutions, please contact your nearest Icom Dealer or Service 
Center.

Problem: Cannot access a Server from a Remote station with the Remote Utility

 LYou can configure the Server information in the Server Propreties screen (Server List screen ➔ <Properties>).

 ❍ “Connection Failed” is displayed under the Server name

   Possible cause 1

    An incorrect IP address, domain name, computer name* or network name is entered 

to request a connection to the Server.

 L If the Remote Utility cannot get the Base station’s IP address using the domain 
name, computer name or network name that you entered, “Cannot resolve the 
name” is displayed next to the name.

   Solution

   q  Check the Base station’s IP address, domain name, computer name*, or network 

name. (pp. 38 to 44, pp. 54 to 57)

   w  Enter the Base station’s correct IP address, domain name, computer name*, or  

network name in the Server Address or Network Name field in the Server  

Properties screen.

    *Only When connecting to the network through a PC

   Possible cause 2

    The control port number is different than that of the Base station.

   Solution

   q Check the Base station’s control port number*. (p. 23)

   w  Enter the correct port number in the Control Port (UDP) field in the Sever  

Properties screen.
    * The default number is “50001.”

   Possible cause 3

    The virtual driver is not installed in the Remote station’s PC.

   Solution

    Install the virtual driver in the Remote station’s PC. 

(See the RS-BA1 Preparations for details.)

 ❍ “Logon Failed” is displayed under the Server name

   Possible cause

   The user ID or password is different than that in the Base station’s Remote Utility.

   Solution

   q Check the Remote station information registered in the Remote Utility. (p. 30)

   w  Enter the correct user ID and password into the User ID and Password fields in the 

Sever Properties screen.

 ❍ “Disabled” is displayed under the Server name

   Possible cause

   The Server is set to “Disable,” to inhibit connecting to it.

   Solution

    Enable the Server by removing a check mark from the Disable box in the Sever 

Properties screen.

“ Connection 

 Failed”

“ Logon  

Failed”

“Disabled”

The connection 

error message 

NOTE: If you could not solve the problem after trying the above solutions, check the following on the Base station side.
When connecting to the network through a PC:
 • Is the Remote Utility activated?
 • Is the Remote Utility added as an exception in the 
Firewall? (pp. 1 to 5)

 • Is your Remote station information registered in the 
Remote Utility’s User List screen? (p. 30)

When connecting to the network directly:
 • Is the radio turned ON?
 • Is the “Network Control” item set to “ON” in the Others 
set mode? (p. 47)

 • Is your Remote station information registered in the 
Others set mode? (p. 49)
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Problem: Cannot access a radio with the Remote Utility

The description in this part is based on the assumption that the connection to the Server has succeeded.
(“Connected” is displayed under the Server name.)

 ❍ “Busy” is displayed under the radio name

   Possible cause

    Another user is currently operating the radio.

   Solution

   Wait for “Busy” to disappear.

 L If you are operating as the Base station, or as an administrator Remote station, you 
can terminate a connection between another Remote station and a radio. (p. 34)

 ❍ “Connect Error” is displayed under the radio name

   Possible cause 1

    Access to the selected radio is inhibited by 

the Server.

   Solution

    Allow the Remote station to access the 

radio with the Base station’s Remote Utility.

   (p. 66)

   Possible cause 2

    The serial port number (default: 50002) or 

the audio port number (default: 50003) is 

not connected. 

   Solution

    Check the Firewall settings for both the 

Base station and Remote station.

    When using the internet, also check the 

router’s port forwarding settings. (p. 12)

“Busy”

“ Connect

 Error”
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NOTE:  If you could not solve the problem after trying the above solutions, check the following on the Base 
station side.

When connecting to the network through a PC:
 • Is the radio turned ON?
 •  Are the correct COM port number and audio device to which the radio is connected selected in the Radio Properties 
screen (Option ➔ Local/Server Settings ➔ Registered Radio List screen ➔ <Properties>)? 

 •  Is the Server not directly accessing the radio using the Remote Controller, without having used the Remote Utility to 
connect to the radio?

When connecting to the network directly:
 • Is the radio turned ON?
 • Is the radio in the remote standby mode?

Problem: Cannot access a radio with the Remote Utility (Continued)

The description in this part is based on the assumption that the connection to the Server has succeeded.
(“Connected” is displayed under the Server name.)

   

 ❍ “COM/Audio Error” is displayed under the radio name

    The following messages are displayed for all possible causes described below.

   Possible cause 1

    An audio device or COM port has been added to the PC, or removed from the PC.

   For the USB device, the USB port number has been changed.

   Solution

    The COM port number or the audio device name may have been changed.

   Reregister the radio in the Registered Radio List screen. (p. 24)

   Possible cause 2

    The audio or serial wiring is disconnected. 

   Solution

    If you are using the USB serial conversion cable or a USB audio, make sure the USB 

cable is firmly connected.

   Make sure the 3.5 (d) mm (1/8”) audio cable is firmly connected.

   Possible cause 3

    Other applications are using the COM port.

   Solution

    If other applications are running at the same time, close them.

   Possible cause 4

    Started the Remote Utility right after the PC has booted. 

   Solution

    Wait for a while after the PC has booted, and then start the Remote Utility.

“ COM/Audio  

Error”
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Problem: Cannot access a radio with the Remote Controller

 

 ❍ When connecting to the radio through the network using the Remote Utility

  Possible cause 1

   Connecting to the radio is unsuccessful using the Remote Utility.

  Solution

  Try again to connect to the radio in the Radio List screen. (pp. 36, 66)

  •  “<<Connected>>” is displayed under the radio name when the connection is successful.

  Possible cause 2

   In the CI-V field of the Remote Controller’s Connect Setting screen, the CI-V settings are different than 

that in the Remote Utility.

  Solution

   In the Connect Setting screen, click <Search>, and then select the correct radio in the Remote Utility menu.

  • The CI-V settings are automatically loaded from the Remote Utility.

  Possible cause 3

   Other applications are using the COM port.

  Solution

   If other applications are running at the same time, close them.

NOTE:

If you could not solve the problem after trying the above solutions, check the following on the Base station 
side.

When connecting to the network through a PC
 • Are the same CI-V address and baud rate that are programmed into the radio set in the Radio Properties 
screen (Option ➔ Local/Server Settings ➔ Registered Radio List screen ➔ <Properties>)?

When connecting to the network directly
 • Is the radio turned ON?
 • Is the radio in the remote standby mode?

 ❍ When directly accessing the radio without using the Remote Utility

  Possible cause 1

   An incorrect COM port number is selected in the Remote Controller’s Connect Setting screen.

  Solution

  q Check the COM port to which the radio is connected, on your PC’s Device Manager.

  w  Select the correct COM port number in the COM Port menu in the Remote Controller’s Connect 

Setting screen.

  Possible cause 2

   The CI-V address or baud rate is different than that are programmed into the radio.

  Solution

  q Check the radio’s CI-V address and baud rate.

   See the radio’s instruction manual to confirm them.

  w  Enter the radio’s correct CI-V address in the CI-V address (Radio) field, and select the radio’s cor-

rect baud rate in the Baud rate (bps) menu, in the Remote Controller’s Connect Setting screen. 

   If the radio’s baud rate is set to “Auto,” select “19200” in the Baud rate (bps) menu.

    If you are using the Spectrum Scope function with the IC-7851, IC-7850, IC-7610, or IC-7300 using 

a USB for the connection, select “115200” in the Baud Rate menu.

  Possible cause 3

   Other applications are using the COM port.

  Solution

   If other applications are running at the same time, close them.

To access a radio with the Remote Controller, configure 
the connection settings in the Connect Setting screen. 
(pp. 72, 73)
Click the Connect Setting icon (  ) on the toolbar, or 
click “Connect Setting...” in the [Option] menu to open 
the screen.
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Problem: Cannot properly control the radio with the Remote Controller

  Possible cause 1

   The same CI-V address is being used by a control software other than the Remote Controller.

  Solution

   Select an address other than “E0” in the CI-V Address (RS-BA1) menu in the Remote Controller’s 

Connect Setting screen. However, this solution does not always solve the problem.

  Possible cause 2

   In the Remote Controller’s Connect Setting screen, a different model name is selected for the radio 

that you attempt to control.

  Solution

   Select the proper model name in the Model menu in the Connect Setting screen.

NOTE:

If you could not solve the problem after trying the solutions described on the previous page and above, check 
the following on the Base station side.
 • Is there any radio that has the same CI-V address in the system?

Problem: The received audio cannot be heard

The description in this part is based on the assumption that the connection to the radio has succeeded.

(“<<Connected>>” is displayed under the radio name.)

  Possible cause 1

   The speaker is not turned ON, or the volume level is too low.

  Solution

   Turn ON the speaker, or adjust the volume level.

  Possible cause 2

   An earphone or other device is connected to the computer in place of the speaker.

  Solution

   Disconnect the device.

  Possible cause 3

   The appropriate audio device is not selected in the Remote Utility. 

  Solution

   Select the appropriate audio device in the Speaker menu in the Connection Setting screen. 

(Radio List screen ➔ <Settings>) (pp. 36, 65)

 L If you connect a new USB audio device to your PC, the audio device which is selected as a 
default device in your PC can be changed. If you select “Default Device” in the Speaker menu, 
please keep that in mind.

  Possible cause 4

   The volume level of the audio device is set to too low on your PC.

  Solution

   Adjust the volume level of the audio device. (pp. 6 to 11)

 LThe PC has the Volume Mixer function that can adjust each application’s audio level. Please check 
that the Remote Utility or the control software is not muted, or set to an appropriate volume level.

  Possible cause 5

   Audio output is disabled in the Remote Utility.

  Solution

   Insert a check mark in the AF Transmission box in the Connection Setting screen. 

(Radio List screen ➔ <Settings>)

  Possible cause 6

   The volume level is too low, or the mute is turned ON in the Remote Utility.

  Solution

   Adjust the volume level in the Received Audio Adjustment screen. (Radio List screen ➔ <AF>) (p. 69)
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NOTE:

If you could not solve the problem after trying the solutions described on the previous page, check the following 
on the Base station side.

When connecting to the network through a PC
 • Is the volume level of the audio device to which the radio is connected set to an appropriate level?

When connecting to the network directly
 • Is the “Network AF” items set to an appropriate level in the Others set mode?

Problem: The transmit audio cannot be output

-  The description in this part is based on the assumption that the connection to the radio has succeeded. 

(“<<Connected>>” is displayed under the radio name).

-  To check the Remote station’s transmit IF signals, use the Transmit Monitor function with the Base station’s  

Remote Utility, or place a receiver near the Remote station’s or Base station’s PC.

  Possible cause 1

   The microphone is not turned ON, or the input level is too low.

  Solution

   Turn the microphone ON and adjust the input level.

  Possible cause 2

   The appropriate audio device is not selected in the Remote Utility.

  Solution

   Select the appropriate audio device in the Mic menu in the Connection Setting screen. 

(Radio List screen ➔ <Settings>) (pp. 36, 65)

   If you connect a new USB audio device to your PC, the audio device which is selected as a default 

device in your PC can be changed. If you select “Default Device” in the Mic menu, please keep that 

in mind.

  Possible cause 3

   The input level of the audio device is set to too low on your PC.

  Solution

   Adjust the input level of the audio device. (pp. 6 to 11)

  Possible cause 4

   Audio input is disabled in the Remote Utility.

  Solution

   Insert a check mark in the MOD Transmission box in the Connection Setting screen.

  (Radio List screen ➔ <Settings>)

  Possible cause 5

   The input level is too low in the Remote Utility.

  Solution

   Adjust the input level in the Transmit Audio Adjustment screen. 

(Radio List screen ➔ <MOD>) (p. 67)

  Possible cause 6

   An incorrect connector is selected in the Remote Controller.

  Solution

   Select the proper radio’s connector which is connected to the Base station’s PC, in the MOD Select 

(Remote ON) menu in the Remote Controller’s MIC SET screen. (p. 74)

NOTE:

If you could not solve the problem after trying the above solutions, check the following on the Base station side.
When connecting to the network through a PC
 • Is the input level of the audio device to which the radio is connected set to an appropriate level?

When connecting to the network directly
 • Is the “Network MOD” items set to an appropriate level in the Others set mode?
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Problem: The received audio is interrupted

  Possible cause 1

   The network data transfer is excessive.

  Solution

   Select a lower sampling rate value in the Sample Rates menu, or a different codec in the Codecs 

menu, in the Connect Settings screen. (Radio List screen ➔ <Settings>)

   First, select the lowest value. If the received audio is not interrupted with the setting, try a higher value, 

and adjust to an appropriate value.

  Possible cause 2

   The capacity of the prebuffer is not enough.

  Solution

   Select a longer value in the Prebuffer (ms) field in the Connection Setting screen. 

(Radio List screen ➔ <Settings>)

   Select as short a value as possible, because longer prebuffers can cause a delay, and make it difficult 

to adjust the audio level. 

  Possible cause 3

   Your PC is overloaded.

  Solution 1

   Shutdown other applications, if running.

  Solution 2

   Reduce the number of radios you are accessing with the Remote Utility. 

NOTE:

 • If you are accessing the radio through a network, removing a check mark from the Retransmission box in 

the Connection Setting screen (Radio List screen ➔ <Settings>) can solve the problem.
 • You can check the simplified packet round trip time, and the average packet loss in the Remote Utility’s 
Server List screen.

Packet round trip time Average packet loss

Problem: The connect settings cannot be changed

   Possible cause 1

    The radio is “Offline.”

   Solution

    Click <Connect> on the Server List screen to connect to the server.

   Possible cause 2

    “<<Connected>>” is displayed.

   Solution

    Click <Disconnect> on the Server List screen to disconnect from the radio.

Problem: The connect settings cannot be changed using the Remote Controller

   Possible cause 1

    The Remote Controller is connected to the radio.

   Solution

    Click <  > to disconnect from the radio.

“Offline”

“<<Connected>>”
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